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Prologo

En el presente documento de Trabajo de Fin de Grado del Grado en Ingenieria
Electrénica Industrial y Automatica, se describen los aspectos fundamentales necesarios para
el cumplimiento de las funciones que cabe esperar de un sistema electroencefalografico
portatil, asi como el disefio de diferentes softwares dedicados a la representacion y estudio
los diferentes tipos de sefiales que este equipo es capaz de adquirir y procesar.

En esta Memoria se recoge, en primer lugar, una descripcion de los fundamentos
tedricos basicos a tener en cuenta necesarios para comprender el campo cientifico en el que

se basa el dispositivo utilizado, la electroencefalografia.

Seguidamente, se describen de forma detallada todos los procedimientos que se han
realizado para la consecucion de las diferentes aplicaciones trabajadas, asi como de la

programacion utilizada en cada una segun su funcion correspondiente.

A partir de ello, se han obtenido una serie de resultados que se muestran fruto del
estudio de las aplicaciones desarrolladas sobre una serie de usuarios. Por otra parte, en este
capitulo adjunta el procedimiento y resultados obtenidos a partir de dos tipos de calibracion
que se han realizado para comprobar el estado del aparato electroencefalografico portatil.
Ademas de ello, se desarrollan aplicaciones practicas de laboratorio dedicadas a la docencia

en este ambito.

Finalmente, se incluye una serie de conclusiones y posibles trabajos futuros sobre todo
el proyecto, ya que a partir de lo que se ha desarrollado en el presente trabajo, es posible
continuar con labores de investigacién en multitud de nuevas aplicaciones y productos de

gran interés.

Los autores, julio de 2015
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0.1. Resumen

El electroencefalograma, encefalograma o EEG, es una prueba que se usa para estudiar
el funcionamiento del sistema nervioso central, concretamente de la actividad eléctrica de la
corteza del cerebro. Para la adquisicion de estas sefiales se ha utilizado un equipo comercial

especifico llamado Emotiv-EPOC.

Este equipo incluye un software con varias funciones para el tratado de la sefial, aunque
con el inconveniente de disponer unicamente de tres licencias para su uso. Es por este motivo
que se pretende disefiar aplicaciones capaces de cumplir las mismas funciones usando el
equipo de medida sin que tengan el inconveniente mencionado, ademas de afiadir algunas

otras funciones y aplicaciones extras.

El disefio en la plataforma LabVIEW, permite la adquisicion y representacion en tiempo
real de las sefiales EEG, ritmos cerebrales y aceleraciones rotacionales de la cabeza del
usuario, asi como guardar estos datos para un posterior estudio. La aplicacion desarrollada
en la plataforma OpenVIiBE permite, ademas de las funciones anteriores, la representacion
grafica de los ritmos cerebrales en modelos 2D y 3D de una cabeza humana también en
tiempo real. Por otro lado, la aplicacion EEGLAB para Matlab, permite reproducir los
resultados obtenidos a partir de la adquisicion EEG para un estudio mas detallado de las

sefales de interés.

Ademas de las aplicaciones desarrolladas, el uso del dispositivo EMOTIV puede ser
aplicado en numerosas aplicaciones, como puede ser en la creacidn de una interfaz entre éste
y circuitos electrénicos en Arduino, o la elaboracién de procedimientos para practicas de
laboratorio.

La gran versatilidad en aplicaciones que ofrece el equipo estudiado, facilita labores de
estudio en el campo neuro-cientifico, las cuales pueden ser de gran relevancia en

diagndsticos de salud o rehabilitacion y en avances cientificos relacionados con esta area.
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0.2. Abstract

The electroencephalogram or EEG, is a test used to study the functioning of the
central nervous system, specifically the electrical activity of the brain's cortex. For the

acquisition of these signals it has been used a commercial device called Emotiv EPOC.

This equipment includes a software with several functions for treating the signal, but
it has the disadvantage of having only three licenses for use it. For this reason the intention
of this project is to design applications that can perform the same functions without having

the obstacle mentioned, and also adding some extra features.

The design in the LabVIEW platform, allows the acquisition and representation of
the EEG signals, brain rhythms and rotational accelerations of the wearer's head and it saves
this data for a further study. The application developed on the platform OpenVIiBE allows
the graphic representation of brain rhythms in 2D and 3D models of a human head. On the
other hand, the EEGLAB for Matlab application allows a more detailed study of the results
obtained from the EEG acquisition made in real time.

In addition to the applications developed, the use of the Emotiv device can be applied
in numerous applications, such as creating an interface between the device and an electronic

circuit on Arduino, or the development of procedures for laboratory practice.

The great versatility in the applications that offers the device studied, facilitates the
study in the work of the neuro-scientific field, which can be of great importance in health or
rehabilitation diagnostics and progress related to this area.
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1.1. Objetivos
1.1.1. Objetivos Generales
e Familiarizacion con los sistemas de electroencefalografia (EEG) desde un
punto de vista electronico.
e Familiarizacion con la adquisicion de sefiales electroencefalogréficas.
e Busqueda y desarrollo de aplicaciones practicas para el uso de un equipo de
electroencefalografia.
1.1.2. Objetivos Especificos

Busqueda y desarrollo de programas en software que permitan establecer una
interfaz de comunicacién con el equipo de electroencefalografia portéatil e
inalambrico Emotiv EPOC.

Blsqueda y desarrollo de programas en software que permitan la
visualizacion y estudio de sefiales EEG en tiempo real, con sus
correspondientes representaciones graficas en una cabeza simulada.
Busqueda y desarrollo de programas en software que permitan guardar
resultados de una electroencefalografia para un posterior estudio mas
detallado.

Desarrollo de aplicaciones destinadas a practicas de laboratorio de
electromedicina desde el punto de vista de un ingeniero.

Desarrollo de aplicaciones practicas haciendo uso del entorno de desarrollo
Arduino.

Calibracién bioldgica del equipo Emotiv EPOC.
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1.2.

Introduccion bioldgica

1.2.1. El encéfalo

El sistema nervioso central estd formado por el encéfalo y la médula espinal. El

encéfalo (cominmente llamado cerebro) es un 6rgano muy importante, ya que controla los

procesos cognitivos, la memoria, las emociones, el tacto, la capacidad para el movimiento,

la vista, la respiracion, la temperatura, el apetito y todos los procesos que regulan nuestro

cuerpo. [1] [2]

El encéfalo se puede dividir en cerebro, tronco del encéfalo y cerebelo:

CEREBRO
(coloreado en naranja)

El cerebro: es la parte mas grande del encéfalo que representa el 85% de su
peso. Las caracteristicas y profundas arrugas (cisuras corticales) de la
superficie exterior del 6rgano son la corteza cerebral, compuesta por materia
gris. Se compone de dos hemisferios, el derecho y el izquierdo.

Tronco del encéfalo: esta formado por el mesencéfalo, la protuberancia anular
(o puente troncoencefalico) y el bulbo raquideo (también Illamado médula
oblongada). Controla varias funciones incluyendo la respiracion, regulacion
del ritmo cardiaco y aspectos primarios de la localizacion del sonido.
Formado por sustancia gris y sustancia blanca.

Cerebelo: esta situado en la parte posterior de la cabeza. Tiene como funcién
coordinar los movimientos musculares voluntarios y mantener la postura, la
estabilidad y el equilibrio. Se compone también de materia gris y blanca y

transmite la informacion a la medula espinal y a otras partes del encéfalo.

CEREBELO

TRONCO ENCEFALICO
(coloreado en naranja)

(coloreado en naranja)

Figura l1a: Cerebro [3] Figura 1b: Tronco del Figura 1c: Cerebelo [3]

encéfalo [3]
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Maés especificamente, otras partes del encéfalo son:

e Lobulo frontal: porcion més voluminosa del encéfalo, situado en la parte
delantera de la cabeza. Interviene en las caracteristicas de la personalidad y
en el movimiento.

e Ldbulo parietal: situado en la zona media del encéfalo, ayuda a la persona a
identificar objetos y a comprender las relaciones espaciales. También
interviene en la interpretacion del dolor y del tacto en el cuerpo.

e Lobulo occipital: es la parte posterior del encéfalo e interviene en la vision.

e Lobulo temporal: los lados del encéfalo o 16bulos temporales intervienen en
la memoria, el habla y el sentido del olfato.

e Médula espinal: es un largo corddn de fibras nerviosas situado en el interior
de la columna vertebral que se extiende desde la base del encéfalo hasta la
parte baja de la espalda; transporta los mensajes entre el encéfalo y el resto

del cuerpo.

Lobulo parietal

Lobulo frontal

Lobulo temporal

Figura 2: Lébulos del cerebro [4]

1.2.2. Las neuronas

Son las células funcionales del tejido nervioso. Ellas se interconectan formando redes
de comunicacion que transmiten sefiales por zonas definidas del sistema nervioso. Suelen
medir entre 4-125 micras. Son células muy excitables, especializadas para la realizacién de

estimulos y la conduccion del impulso nervioso. [5]
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La forma y estructura de cada neurona se relaciona con su funcion especifica, la que

puede ser:

e Recibir sefiales desde receptores sensoriales
e Conducir estas sefiales como impulsos nerviosos, que consisten en cambios
en la polaridad eléctrica a nivel de su membrana celular

e Transmitir las sefiales a otras neuronas o a celulas efectoras
En las neuronas se pueden distinguir tres partes fundamentales, que son [6]:

e Somas o0 pericarion: corresponde a la parte mas voluminosa de la neurona.
Aqui se puede observar una estructura esférica llamada nticleo. Este contiene
la informacion que dirige la actividad de la neurona. Ademas en el soma se
encuentra el citoplasma. En él se ubican otras estructuras que son importantes
para el funcionamiento de la neurona.

e Dendritas: son numerosas y aumentan el area de superficie celular disponible
para recibir informacidn desde los terminales axonicos de otras neuronas.

e  AXxOn: es una prolongacion unica y larga que conduce el impulso nervioso de
esa neurona hacia otras células ramificandose en su porcion terminal

(telodendrén).

La transmision de los impulsos nerviosos entre dos neuronas tiene lugar en la
conexidén entre ambas llamadas sinapsis. Las sinapsis se establecen normalmente entre la
parte terminal de un axén y el cuerpo o las dendritas de otra neurona. La comunicacién entre
dos neuronas se lleva a cabo en los botones sinapticos, situados en cada extremo de las

ramificaciones del axdn, que conectan con otra neurona en las sinapsis. [7]
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Figura 3: Partes de una neurona [8]

La sinapsis puede ser de dos tipos: [9]

Quimica: la membrana presinaptica libera una sustancia quimica llamada
neurotransmisor y esta pasa a unirse con los receptores que tiene la membrana
postsindptica. Dentro de las sinapsis quimicas se reconocen distintos
neurotransmisores (moléculas como la acetilcolina, dopamina, glutamato,
etc.) y neuroreceptores, con canales que permiten transformar una sefial
quimica intercelular a una sefial quimica intracelular.

Eléctrica: las membranas de ambos tipos de neuronas estan conectadas por
canales a través de los cuales se transmite corriente eléctrica. Ello produce
cambios de voltaje en la célula presinaptica que a su vez condicionan cambios
en la célula postsinaptica. Son extremadamente rapidos pero mas raros en el

cuerpo. Se les encuentra especialmente en el ojo y en el corazén.
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La sinapsis ocurre en una sola direccion pues cada membrana tiene las propiedades
de la funcién que realiza. EIl impulso sinaptico puede diversificarse en varias neuronas, del
mismo modo varios impulsos pueden converger en una sinapsis, como se puede observar en
la figura 4.

Espacio
intersinaptico

& ’/"—\‘_ Neurona

postsinaptica

Neurona
presinaptica

Receptores
de membrana

Vesiculas con
neurotrasnmisores
neurotransmisores

Figura 4: Sinapsis quimica [10]
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1.2.3. La Electroencefalografia

Introduccion

Desde que el psiquiatra aleman Hans Berger consiguio en 1924 demostrara en el
cerebro humano oscilaciones de potencial, que describioé por primera vez en 1929, y cuya
inscripcion denomind “‘electroencefalograma” del hombre, la electroencefalografia ha

experimentado hasta nuestros dias un desarrollo dindmico.

El interés se centrd ante todo en la consecucion de unas bases para el empleo préctico
del EEG en el diagnostico clinico. Pero la electroencefalografia no alcanzé un empleo méas
amplio en la exploracion clinica sistematica hasta que aparecieron en el comercio

instrumentos de registros de varios canales que ofrecieron garantias.

Actualmente, la electroencefalografia reclama grandes exigencias a una técnica de
intensificador exenta lo mas posible de distorsiones; esta exigencia se consiguid gracias a
los progresos realizados por la moderna tecnologia electrénica en las ultimas décadas.
Entretanto han aparecido un gran nimero de trabajos excelentes que han conferido el EEG,
como documento grafico, un valor y un lugar definitivos en el diagnéstico y la investigacion
clinica. Asi, la electroencefalografia se ha revelado en los afios como un procedimiento

indispensable en muchos terrenos de la ciencia. [11]

. Qué es la electroencefalografia?

La electroencefalografia es la parte de la medicina que estudia la obtencion e

interpretacion de los electroencefalogramas.

El electroencefalograma, encefalograma o EEG, es una prueba que se usa para
estudiar el funcionamiento del sistema nervioso central, concretamente de la actividad
eléctrica de la corteza del cerebro. Consiste esencialmente en registrar mediante electrodos
especiales las corrientes eléctricas que se forman en las neuronas cerebrales, y que son la
base del funcionamiento del sistema nervioso. Gracias a él se pueden diagnosticar

alteraciones de la actividad eléctrica cerebral que sugiera enfermedades como la epilepsia,
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narcolepsia 0 demencias, entre muchas otras. También es una prueba imprescindible para

certificar una muerte en un paciente en coma. [12]

Diferentes tipos de onda cerebrales

Un EEG registra los patrones de la actividad cerebral. Entre las formas de onda

bésicas se encuentran los ritmos alpha, beta, theta y delta. [13] [14]

Las ondas alpha se producen a una frecuencia de 8 a 12 ciclos por segundo (Hz) aun
ritmo regular. Estdn asociadas con estados de relajacion. Estan presentes solo cuando
estamos despiertos, pero con los ojos cerrados. Por lo general, desaparecen cuando abrimos

los 0jos 0 comenzamos a concentrarnos mentalmente.

Las ondas beta se producen cuando el cerebro estd despierto e implicado en
actividades mentales. Son ondas amplias y las de mayor velocidad de transmisién de las

cuatro. Su frecuencia oscila entre 14 y 30-35 Hz. Denotan una actividad mental intensa.

Las ondas theta se producen a una frecuencia de 4 a 7 Hz. Se alcanzan bajo un estado

de calma profunda. Son mas comunes en nifios y adultos jovenes cuando estan dormidos.

Las ondas delta presentan una frecuencia de 0,5 a 3,5 Hz. Normalmente solo
aparecen en nifios pequefios durante el suefio aunque se reflejan también en estados

profundos de suefio.

Aparte de los cuatro ritmos principales muchos cientificos reconocen un quinto ritmo
Ilamado gamma. Son las ondas de mayor frecuencia y menor amplitud que se registran. El

estado “normal” de aparicion en nuestro cerebro es de una frecuencia de unos 40Hz. [15]
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Figura 5: Ritmos cerebrales [16]

Razones por las que se realiza el EEG

Como ya se ha mencionado anteriormente, el EEG se utiliza para observar la
actividad cerebral. Se puede emplear para diagnosticar o monitorizar las siguientes
afecciones: [17]

e Cambios anormales en la quimica corporal que afectan al cerebro

e Enfermedades cerebrales como el mal de Alzheimer

e Confusién

e Traumatismos craneales

e Episodios de desmayos o periodos de memoria que no se pueden explicar de
otro modo

e Infecciones

e Convulsiones

e Tumores

El EEG tambien se usa para:

e Evaluar problemas con el suefio (trastornos del suefio)

e Monitorizar el cerebro durante una cirugia cerebral
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Neurotecnologia

El EEG es una técnica que forma parte de la neurotecnologia. Esta es un conjunto de
herramientas que sirven para analizar e influir sobre el sistema nervioso del ser humano,

especialmente sobre el cerebro.

La funcién del modo de aplicacion de la tecnologia puede dividirse en invasivas y no
invasivas. Las primeras requieren de la cirugia para incorporar receptores o emisores cerca
0 junto a areas del cerebro que van a ser afectadas. Las segundas no requieren de cirugia

eliminando los inconvenientes derivados de la intervencion quirargica. [18]
Técnica no invasivas:

e FMRI (imagenes por resonancia magnética funcional)
e EEG (electroencefalograma)

e MEG (magnetoencefalograma)

e PET (tomografia de emision de positrones)

e MRS (resonancia magnética espectroscépica)

e 2D Ultrasound Imaging

e NIRS (topografia dptica)

e DOT (tomografia NIRS)

e EMIT (tomografia cerebral por computacion activa de microondas)
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1.3. Introduccion electrénica

1.3.1. Analisis espectral de una sefal

El teorema de Fourier nos dice que cualquier sefial temporal esta constituida por una
0 mas ondas senoidales a diferentes frecuencias, cada una con una amplitud y fase
determinada. El espectro de una sefial es una representacion en el dominio de la frecuencia,
esto es, para un rango de valores de frecuencia que idealmente puede ir desde 0 Hz hasta
infinito (en la practica se selecciona un rango finito de frecuencias de interés), de magnitud
y fase de cada componente de frecuencia presente en la sefial que esta siendo objeto de

estudio.

Analizando la forma de onda en el tiempo no es nada facil determinar cémo ha sido
creada, es decir, cuales son sus componentes frecuenciales. Por el contrario, en un diagrama
de Bode de una sefial se representa la magnitud y fase de sus componentes en el dominio de
la frecuencia. Un instrumento que nos permita obtener diagramas de magnitud y de fase es

de gran utilidad para caracterizar con mayor precision una sefial o un conjunto de ellas.

El espectro de una sefial f (t) puede determinarse mediante la denominada
transformada de Fourier: [19]

FLf(0]= F(@)= [ f(e ™ d
et (Ec. 1)

1.3.2. Tipos de reqgistros electroencefalograficos

Los distintos pares de electrodos utilizados para llevar a cabo un registro de
encefalografia se combinan constituyendo los montajes. Hay dos tipos basicos de montajes:
bipolar (transversal y longitudinal) y monopolar (o referencial). El bipolar registra la
diferencia de voltaje entre dos electrodos colocados en areas de actividad cerebral, mientras
que el monopolar registra la diferencia de potencial entre un electrodo ubicado en una zona
cerebral activa y otro colocado sobre un area sin actividad o neutra (por ejemplo el I6bulo
de la oreja); o bien, la diferencia de voltaje entre un electrodo colocado en una zona activa 'y

el promedio de todos o algunos de los electrodos activos. [20]
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El Emotiv EPOC utiliza un tipo de registro monopolar (referencial) haciendo uso de
dos referencias conectadas simultdneamente, cuyos correspondientes electrodos se

encuentran proximos a las orejas del paciente.

I

Figura 6: Registro unipolar EEG del Emotiv Epoc (Fuente: Elaboracién propia)

1.3.3. Electroencefalégrafo

En una exploracion electroencefalogréafica, son captadas las oscilaciones de potencial
que aparecen en la superficie corporal por un gran niamero de electrodos simultaneamente,
transmitidas a un intensificador con entrada poliéhmica y registradas después por canales
registradores. Un sistema semejante (representado esquematicamente en la figura 8 mas

adelante) se construye por lo general en forma de una unidad como electroencefalégrafo.
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Figura 7: Representacion esquematica del procedimiento de registro de un EEG

El curso exacto de un registro electroencefalogréfico esta expuesto en la figura 7 A
y B. Los electrodos en la superficie cefélica facilitan la conexion entre los tejidos, en los que
se origina la actividad eléctrica encefalica y los peldafios de entrada del intensificador; la
conexion de dos electrodos proporciona una sefial electroencefalografica que es registrada

mediante un dispositivo inscriptor. Por lo general, se disponen 16 canales registradores.

Entre los electrodos y el cuero cabelludo existen grandes resistencias. La resistencia
original de la actividad eléctrica cerebral escapa a nuestro influjo, es relativamente pequefia
y puede ser menospreciada. La conexién desde el electrodo E1 al intensificador conduce la
sefial de entrada 1 (input terminal 1; rejilla 1); la sefial de entrada 2(input terminal 2; rejilla
2). Entre los electrodos y el intensificador se halla el colador, que capta las sefiales de los
electrodos y las transmite unidas en un cable. Las sefiales de entrada 1 y 2 pasan a través del
conmutador de programa al intensificador del electroencefaldgrafo, cuya resistencia de
entrada en los modernos aparatos, visto desde el lado de las sefiales, representa la resistencia
de entrada del intensificador amortiguador. Con ello queda completado el peldafio de entrada
de intensificador. En la derivacion electroencefalogréfica se utilizan por lo general para la
intensificacion de las sefiales intensificadoras que corriente alterna, ya que los
intensificadores pata corriente continua son extraordinariamente sensibles con respecto a la
estabilidad de la linea cero; la linea cero se desplaza facilmente. Antes de iniciar la
derivacion, deben comprobarse por separado todos los canales del EEG, para comprobar si
estan electronica y mecanicamente exactamente enfocados sobre la linea cero. En los
modernos aparatos se puede prescindir de esta medida, puesto que el enfoque sobre la linea

es plenamente automatico.
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Cada canal de un electroencefalografo deberia transmitir sin distorsion las sefiales
captadas por los electrodos; al respecto deben tomarse en cuenta algunas peculiaridades. Con
el fin de reducir al minimo la distorsién de las sefiales ingresadas, las resistencias de los
electrodos deberian ser pequefias (maximo 10 kohm). De este modo, la resistencia de origen
del EEG esta libre de carga. Es necesario un montaje en cadena de varios peldafios de
intensificador en el sistema de intensificacion con el fin de obtener un factor de
intensificacion optimo (gain = ganancia), que eleva la amplitud de la tension de entrada sobre
un indicador de nivel para encauzar el sistema inscriptor. El factor de intensificacion se
calcula a través de la relacion entre la tension de la sefial de salida y la tension de la sefial de

entrada. No tiene dimension y se puede expresar en decibelios. [11]
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Figura 8: Esquema bésico de correcciones de un registro EEG [11]
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Figura 9: Correccion suplementaria en la fase de
entrada, detalle (A/B) de la figura anterior [11]

1.3.4. Electrodos

El registro del EEG es mas dificil que el de otros biopotenciales, porque las sefiales

electroencefalograficas tienen voltajes menores.

La aplicacion exacta y segura de los electrodos sobre el cuero cabelludo tampoco es
siempre facil. El electrodo ideal debiera ser indoloro y facil tanto de colocar como de retirar.
Los electrodos tienen diversas formas y pueden ser de cualquier metal que, con la ayuda de
una solucién salina fisioldgica o de una pasta conductora, pueda establecer contacto con las

superficies de la cabeza.

Existen varios tipos de electrodos: de disco, de aguja, de piel biopotencial, de
almohadilla, etc. Antes de cada exploracion debe medirse la resistencia de los electrodos, la
que, en lo posible, debe ser inferior a 10 kohm. [11]
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Figura 10: Electrodos: a) electrodo de almohadilla; b) electrodo de
disco; c) electrodo de aguja; d) electrodo biopotencial cutaneo [11]

Disposicion de los electrodos

El montaje de los electrodos sobre los puntos de registro en la superficie de la cabeza
se lleva a cabo seguin una distribucion sistematica. Esta puede variar de un laboratorio a otro,
pero en el dmbito de un mismo laboratorio debiera permanecer constante. Con fines
comparativos es preferible trabajar con un sistema de disposicidn de electrodos internacional
y unitario. En los Gltimos afios se ha comprobado que en la mayoria de los laboratorios de
EEG se emplean la disposicion de electrodos aconsejada por la Federacion Internacional de
Sociedades de Electroencefalografia y Neurofisiologia Clinica. Este sistema de registro se

conoce como sistema 10-20 (ten-twenty System).

Se parte de cuatro puntos determinados en la cabeza, del nasion (el punto ubicado en
la base de la nariz sobre la sutura frontonasal), del inién (punto situado en la parte posterior
de la cabeza que se corresponde con la protuberancia occipital) asi como de los dos puntos

preauticulares correspondiéndose cada uno de ellos con el comienzo del hueso cigomatico
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delante del trago. Para determinar la posicion de los electrodos se considera como 100% al
valor de la distancia que separa al nasion del inion medida sobre el vertex en la linea media.

La posicién de los electrodos se identifica con letras y nimeros, sobre el hemisferio
derechos con pares y sobre el hemisferio izquierdo con impares. Las letras identifican cada
region de la cabeza; frontopolar (Fp), frontal (F), temporal (T), central (C), pariental (P),
occipital (O), con lo cual se dice inicamente que se registra sobre esas regiones de la cabeza.
Esto no significa, sin embargo, que la informacion deba proceder de las regiones cerebrales
ubicadas bajo ese punto. A cada uno de los electrodos ubicados sobre la linea media se le
asigna la letra zeta minuscula (z de zero) (Fz, Cz, Pz). Los electrodos del 16bulo de la oreja
para el registro con una referencia comun se designan con Al y A2 (A=auricular). Las
posiciones de los electrodos determinadas por este sistema no tienen necesariamente que ser

utilizadas en su totalidad. En cada caso su nimero puede ser libremente elegido. [11]

Punto
prearicular

\

Punto
prearicular

X Punto de medicion

Inién

Figura 11: Orden de los electrodos segun el sistema 10-20 [11]
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1.4. Electroencefalografo portatil Emotiv EPOC

En el presente proyecto la adquisicion de la sefial EEG se realiza mediante el EPOC
headset, realizado por la empresa californiana Emotiv Systems. [21] Se trata de un
dispositivo portéatil que se forma a partir de 16 sensores posicionados especificamente en
ciertas areas del cuero cabelludo, 14 para obtener la sefial y 2 de referencia, los cuales envian

los datos inalambricamente a un receptor USB.

Seeent BStiseTlans

Figura 12: Emotiv Epoc headset Figura 13: Sensores Emotiv

En este caso, como vemos en la figura 2, las referencias toman el nombre de CMS'y
DRL a cada lado, los cuales deben ser ubicados detras de la oreja, cercanos a los mastoides,
0 encima de ella, siendo estos puntos muy importantes para el correcto funcionamiento del
dispositivo, ya que si ho son ubicados correctamente o si no entregan un potencial cero, no

se obtendra una correcta lectura sobre la sefial y el resto de los sensores no reportara sefial
alguna. [22]

En el Anexo | del presente documento se podra ver una informacion méas detallada

acerca de la colocacion e instalacion del dispositivo.
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1.4.1. Hardware Emotiv EPOC

El “Emotiv Epoc headset” es un dispositivo para la adquisicion y procesamiento de
manera inalambrica de sefiales neuronales. Utiliza un conjunto de sensores para sintonizar
las sefiales eléctricas producidas por el cerebro para detectar pensamientos, sentimientos y

expresiones faciales. Las especificaciones del dispositivo estan en la tabla 1

Numero de canales

Nombre de los canales (Localizacion 10/20
Internacional)

Metodo de muestreo

Frecuencia de muestro

Resolucion

Ancho de banda

Filtrado

Rango dinamico (entrada de referencia)
Modo de acoplamiento

Conectividad

Potencia

Duracion de la bateria

Impedancia de medicidon

14 (maés las referencias CMS/DRL)
AF3,F7,F3,FC5,T7,P7,01,02, P8, T8, FC6,
F4, F8, AF4

Sequential sampling. Single ADC

128 SPS (2018 Hz internal)

14 bits 1 LSB= 0.51uV (16 bit ADC, 2 bits
instrumental noise floor discarded)

0.2-45Hz, Filtro digital notch de 50Hz y 60Hz
Built in digital 5th order Sinc filter

84001V (pp)

AC couple

Wireless, 2.4GHz band

LiPoly

12 horas

En tiempo real de la calidad del contacto con

el sistema

Tabla 1: Especificaciones Emotiv EPOC [23]

° Electrodos:

Los tipos de electrodos utilizados son superficiales distinguiéndose ya que son
adheridos, es decir, que se conforman de pequefios discos metalicos que se fijan con una

pasta conductora entregando con esto una resistencia de contacto a la sefial muy baja.
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Estos electrodos se encuentran sujetos a una especie de brazos de plastico que
garantizan su correcta ubicacion ya que son correctivos de ciertos puntos dentro del cuero
cabelludo. Su posicion se basa en el sistema internacional 10-20 explicado anteriormente.
[11] Cada uno de los electrodos esta también dotado de una almohadilla que es humedecida

en una solucion salina la cual favorece la conduccién de la actividad eléctrica.

Uno de los principales problemas de estos electrodos es la oxidacion de las pequefias
chapas de metal que contactan con las almohadillas ya que dicha oxidacién produce una
pérdida de prestaciones importante. Para evitarlo es recomendable limpiarlos con agua

destilada después de cada uso.

Figura 14: Almohadillas Figura 15: Chapas de metal

e Acondicionamiento y filtrado de la sefial

Esta parte permite una banda de adquisicién efectiva de 0.2-45Hz, esto se consigue
gracias a un filtro paso-bajo y un paso-alto, utilizando un filtro digital de 5° orden,
conseguimos eliminar el ruido a 50Hz y 60Hz. El acondicionamiento de sefial permite una
resolucion de 0,51uV, con un ancho de banda de 16 bits (14 efectivos) (Tabla 1). En cuanto
a la frecuencia de muestreo que puede recopilar por segundo son 128, ya que el
acondicionamiento y filtrado tiene un coste de computacion y afiade latencia a la sefial, por
ello se ve mermado desde una frecuencia interna de 2.048Hz a una frecuencia externa de

128Hz. La parte fisica puede verse en las siguientes figuras.
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Figura 16: Placa 1 [24] Figura 17: Placa 2 [24]

e Alimentacién

La alimentacion del dispositivo viene determinada por una bateria Lipo (Polimero de
Litio) con una capacidad de 800mA y un voltaje de 3,7v. La carga de dicha bateria, la cual
puede llegar a durar hasta 12 horas, se realiza mediante un conector mini-USB. La placa
dispone de un led rojo, que significa que se esta cargando, y un led verde que significa que

la carga se ha completado.
e Comunicacion

Este sistema se comunica mediante Bluetooth lo cual convierte al Emotiv EPOC en
un dispositivo versatil sin necesidad de estar conectando ningun cable. La comunicacion

viene encriptada, de modo que no es posible ver qué se esta transfiriendo.
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Figura 18: Placa 3 [24] Figura 19: Receptor USB

1.4.2. Software Emotiv EPOC

El software a emplearse es el que viene equipado con el dispositivo, que en este caso
es el SDK Research Edition, que viene incluido con una licencia para tres Unicos usuarios.
Este esta destinado a la investigacion, de ahi su nombre “Research Edition”, por lo que hace
que la licencia sea personal e intransferible. Este software también incluye las librerias

necesarias que permiten comunicarse con el hardware explicado anteriormente
A continuacion se analizardn los componentes del kit de Emotiv:
e Programa Control Panel

Dentro de las aplicaciones desarrolladas por la compafiia Emotiv se encuentra el
Control Panel, que permite el acceso a distintas funciones obtenidas a partir del casco Emotiv
EPOC.

En dicho panel se puede observar en la parte superior el estado del sistema, el tiempo
que el EPOC se encuentra conectado, la intensidad de la sefial inalambrica y el nivel de la
bateria. Estos datos son muy importantes tenerlos presentes ya que de esto parten todas las

demas aplicaciones. También se puede elegir o crear un usuario.
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%] Emotiv Control Panel 2.0.0.20-PREMIUM

Application  Connect  Help
ENGINE STATUS

SYSTEM STATUS: EmoComposer connected
S D K SYSTEM UP TIME: 0.250215

WIRELESS SIGNAL : Good ©® © © ©
2.0.0.20-PREMIUM

BATTERY POWER: High © © © ©

HEADSET SETUP EXPRESSIV SUITE | AFFECTIV SUITE COGNITIV SUITE
STATUS: OK

USER STATUS
HEADSET : USER:

0 ~| | Alejandro =
[ o0 vsce [

HEADSET SETUP GUIDE

STEP 1

STEP3

jon i reported as Good by looking at the
that the

sure
that the single
e e

Figura 20: Control Panel

Ademas se puede visualizar el estado de los electrodos. Dependiendo del color en el

que estén se puede saber qué electrodos deben corregirse. A continuacion se muestra el

significado de los colores:

Negro
Naranja
Naranja
Amarillo
Verde

Sin sefial

Sefial muy pobre
Sefial pobre
Sefial aceptable

Sefal buena

Tabla 2: Significado colores seglin conductancia

Se recomienda que no se utilice el dispositivo para adquirir las sefiales hasta que se

visualicen en amarillo/verde todos los electrodos. Se puede observar también cuatros

pestafas las cuales se explicaran brevemente:

v Headset Setup: Referida anteriormente. Sirve para comprobar el estado de los

Sensores.
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v Expressiv Suite: Esta aplicacion usa la sefiales electroencefalograficas para

determinar los gestos faciales que el usuario realiza.

HEADSET SETUP | EXPRESSIV SUITE | AFFECTIV SUITE | COGNITIV SUITE
STATUS: OK Training

BLINK

RIGHT WINK

LEFT WINK

LOOK RIGHT/LEFT

® e e

RAISE BROW

FURROW BROW

SMILE

) ® ®

®
@

CLENCH

RIGHT SMIRK

LEFT SMIRK

® @

LAUGH

Figura 21: Expressiv Suite

Dentro de los gestos que pueden ser determinados tenemos pestariear, guifiar el ojo,
sonreir, mirar hacia los lados, etc. Cada uno seran representados por el robot y se generara

una serie de graficas con los niveles.

Se pueden ver dos pestafias: Sensitivity y training, cada una de estas tiene sus
funciones. EI modo de sensibilidad posee deslizadores que permiten configurar la deteccién
de la expresion facial mientras que el entrenamiento permite al usuario entrenar estos datos

y mejorar su deteccion.

v Affectiv Suite: Esta pestafia corresponde al modo afectivo donde se detectan
los cambios emocionales que se generan sobre el usuario. Estos no requieren
entrenamiento ya que se generan directamente por las caracteristicas
inherentes de las sefiales cerebrales, sin embargo, cada una de estas
caracteristicas se guarda individualmente al generar el nuevo usuario antes
mencionado.

v Cognitiv Suite: La Ultima pestafia esta referida a la deteccion y entrenamiento
del modo cognitivo. Evalua la actividad de las sefiales cerebrales del usuario

producidas por el intnto de realizar el movimiento de un objeto real o virtual.
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Se ha disefiado para realizar 13 tipos de movimientos: 6 movimientos en la

direccion, 6 de rotacion y el desaparecer del objeto.

Mientras mas se incrementa la cantidad de movimientos a realizar, la dificultad
aumenta. Evidentemente se necesita de un adecuado tiempo de entrenamiento para poder

tener un control del objeto y mas aun si se esta haciendo uso de varios movimientos a la vez.

HEADSET SETUP | EXPRESSIV SUITE | AFFECTIV SUITE = COGNITIV SUITE
Action Training Advanced Settings Challenge

ACTION CONTROL
CURRENT ACTION Neutral

DETECTION STATUS Deactivated: Neutral training required

DIFFICULTY LEVEL Easy

OVERALLSKILLRATING [} 0% J

| Push ‘l 0% '\
~

To begin the Cognitiv experience, switch to the Training tab and
start training on Neutral first.

Power

Figura 22: Cogpnitiv Suite

El panel usa un cubo virtual sobre el cual se representan los movimientos que fueron
mencionados Sobre este control se tienen submenus referidos a Action, Training, Advanced,

Setting y Challenge.

e Programa EmoComposer

Este programa emula el comportamiento de la EmoEngine (dispositivo). Esta
destinado a ser utilizado como una herramienta de desarrollo y pruebas. Esto hace que sea
facil de enviar eventos simulados y solicitar respuestas a las aplicaciones que utilizan la
libreria de Emotiv. ElI manejo del programa es sencillo, ya que el usuario solo debe ajustar

los valores que desea enviar al Control Panel.
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9] EmoComposer CORES

' Application  Help

EmoScript | Interactive

Player 0 v | EmoState Interval: [0,25 %] sec
Send
[] Auto Repeat

Contact Quality | Detection

EmoState

Time [0.250215 secs
Cognitiv | Neutral ~| lo00 2

[Push skl | [0,00 [2] overaliski 0,00 2
Affectiv Excitement 0,00 [3 LongTerm 0,00 %

Engagement/Boredom  [0,00 |5

Meditation 0,00 |5
Frustration 0,00 |3
Upperface |Raise Brow v 000 5]
Lowerface |Smile v | 000 2
Eye |Bink v O Acive  [¥] AutoReset
Training Results EmoEngine Log

Cognitiv

66: [Rep! h ercor code 0 ~
67: [Request] GET_OPTIMIZATION_PAF

oK -

Expressiv 65: Request] GET_OPTIMIZATION_PAF

Os Z < >

Figura 23: EmoComposer

° Programa EmoKey

Emokey traduce todos los resultados de la deteccién de Emotiv para ponerlo sobre

ciertas teclas predefinidas para el teclado, creando unas reglas l6gicas definidas por el

usuario creando una interfaz entre el usuario y Emokey. Luego, este conjunto de pulsaciones

de teclas conocidas como “Mapping Emokey” pueden ser guardadas para una préxima

reutilizacion.

. Programa Testbench

TestBench permite apreciar las sefiales de los electrodos del Epoc.
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Aoplication Tosls  Meker  Help
Coreac usty 5T [Gro | oo Packets
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& MOaves

T @@
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Ferron Sample

Resdy, Marker numes: 8

Figura 24: Testbench

Para grabar la sefial primero se selecciona “Save Data” y aparece una ventana en la
cual al pulsar “Select” se selecciona una carpeta y se nombra al archivo. También se tiene la
opcion de grabar las sefiales y procesarlas en otro programa como Matlab. El archivo que se
graba es de extension .edf y para abrirlo en Matlab se debe pasar el archivo a formato .csv.

Este programa posee 4 pestafias: EEG, FFT, Gyro, Data Packets.

La segunda pestafia muestra la FFT de la sefial y también existe la posibilidad de

realizar el filtrado, ademas podemos visualizar la potencia de Delta, Theta, Alpha y Beta.

Y] Emotiv TestBench v1.5.1.2 - O EE
Application  Tools Marker Help

EEG | FFT (G | DwaPackets
Cranos
A

longn 2562

Magnitude (dB)

wp [ [

® [0 v

Windowng i R S — e e N e Y B
ko R e 0 5 10 15 20 2 0 3 4 45 50 55
Battery

Evortlog pmex 00T [ 001

I 1

Deita (142 Theta (47Hz) Alpha (7-12+z) Beta (1330H2) Custom

Ready. Marker numer: 0

Figura 25: FFT
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La pestafia “Gyro” contiene las graficas correspondientes al giréscopo que contiene
el EPOC headset, el cual estd compuesto por dos acelerdmetros que facilitan la informacion
sobre los movimientos que el usuario realice con su cabeza, representando su aceleracion

rotacional en el tiempo.

Finalmente, la pestafia “Data Packets” muestra el contador de paquetes de datos y el

indicador de paquetes perdidos.
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Capitulo 2

Disenos para la adquisicion y procesamiento
digital de la seial EEG
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2.1. Disefio en LabVIEW

Para la adquisicion de las sefiales en tiempo real se ha elaborado un programa en
LabVIEW Instrument que pretende imitar las funciones que presenta el propio Testbench
del software Emotiv EPOC. Para ello, el programa elaborado cuenta con varias funciones de

visualizacion, las cuales se explicaran mas adelante con mayor detalle.

La herramienta grafica LabVIEW (Laboratory Virtual Instrumentation Engineering
Workbench), es ideal para la simulacion de sistemas de medida y control principalmente
para instrumentos electrénicos programables, ya que integra una gran variedad de
herramientas Utiles para ingenieros y cientificos en la elaboracion de diversas aplicaciones.
Para la programacion, cuenta con dos ventanas de trabajo: panel frontal y diagrama de

bloques; como se muestra en la siguiente figura.

o T R | i Uttt 1 Block Disgram —lw] =

anel
siect Operste Taaks Windaw  Help Fie Fan Wi Project Operate Tooh  Window Feip
Ao o o | T [ [ [ o 1 801 o e B | o . (S5

Figura 26: Panel frontal y diagrama de bloques en LabVIEW

LabVIEW posee un toolkit especifico para la comunicacion con el dispositivo
Emotiv EPOC. Es por ello que sera necesario descargar este paquete de datos para hacer uso
de las herramientas que se implementan en el mismo. Ademas, para la descarga ha sido

necesario instalar un programa llamado VI package manager.

Este programa hace posible descargar las diferentes librerias y paquetes de datos
disponibles para el uso en LabVIEW de diferentes herramientas especificas para dispositivos

y aplicaciones varias. En este caso, se descargara el paquete de datos Emotiv Toolkit.

Una vez finalizada la descarga y posterior instalacion, se cargaran las funciones y

herramientas correspondientes de manera automatica en la paleta de controles de LabVIEW.
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2.1.1. Libreria Emotiv Toolkit para LABVIEW

Para empezar a utilizar la libreria, es necesario tener en cuenta los siguientes vi para

conseguir una correcta interfaz entre el dispositivo EPOC y LabVIEW

1. EmotivCreate Task.vi: en este vi se debe ubicar la direccion del archivo edk.dll y
colocar el path del subvi.

2. EmotivStart Task.vi: se utiliza para iniciar la interfaz.

3. Estructura while: aqui se programa lo que se desea realizar.

4. Emotiv Read.vi: se utiliza dentro del bucle while en el caso de que se desee el
comportamiento de las sefiales EEG ante acciones cognitivas 0 expresivas.

5. EEG Data.vi: se encarga de adquirir las sefiales EEG que provienen de cada
electrodo.

6. Set Marker.vi: se encarga de enviar marcadores durante la adquisicion de las sefiales
EEG.

7. Emotiv Stop Task.vi: se utiliza fuera del bucle while para establecer la interfaz de
comunicacion.

8. Error out: se utiliza para visualizar un error en caso de que se interrumpa la conexion

entre LabVIEW vy el dispositivo.

A continuacion, se muestra como ejemplo el esquema gréafico utilizado en la préctica
de laboratorio nimero 1 correspondiente al Anexo 2 del presente documento, en el cual

pueden apreciarse los diferentes vi explicados anteriormente.

Ernotiv Read.vi Emaotiv Stop Taskwi

B Chediedll Emotiv Create Task.wi  Emotiv Start Task.vi

Emotiv

ruta edk.dll (l]llE: Heow | Fratis

EmoEngine

error out

1t

Smile ¥

stop

[zror
|I| TF

Figura 27: Ejemplo de utilizacion de los VI de la libreria Emotiv Toolkit
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2.1.2. Descripcién del programa

El programa que se ha desarrollado para la adquisicion y estudio de las sefiales EEG
puede dividirse en cuatro partes distintas correspondientes cada una de ellas a una aplicacion

que desempefia una funcién determinada:

. EEG
. FFT (Fast Fourier Transform)
. GYRO

. GUARDAR EN CSV

Antes de ejecutar el programa, debera seleccionarse en LabVIEW, concretamente en
el lugar habilitado para ello, el path o ruta de acceso del archivo edk.dll correspondiente al
dispositivo EPOC que se esté usando.

Este archivo puede encontrarse en la carpeta de instalacion del Software que
incorpora el propio equipo Emotiv EPOC. La ruta en la que deberia encontrarse el archivo
edk.dll es la siguiente:

- Archivos de programa \ Emotiv Research Edition SDK \ dll \ 64 bit

El diagrama de bloques correspondiente a cada una de las cuatro partes, se llevara a

cabo en el interior de un mismo bucle While Loop comun.

EEG

En esta parte del programa tendra lugar la visualizacion de las diferentes sefiales EEG
que proporciona cada uno de los 14 electrodos encargados de captar cada sefial
correspondiente del dispositivo de acuerdo con el sistema 10-20, omitiendo lo que se
visualizaria en los 2 electrodos de referencia 0 masa. Asimismo, cada electrodo se

correspondera con un canal distinto.

Cada sefial puede habilitarse o deshabilitarse para la visualizacion por separado de
aquellas unicas que se deseen estudiar simplemente seleccionando cada sefial en cuestion

con el boton derecho del mouse y marcando la opcién Plot Visible seglin convenga.
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De este modo, el panel frontal de la parte del programa en LabVIEW dedicado a la
adquisicion y visualizacion de las catorce sefiales EEG se mostrard de forma similar a la

figura 28.

EMOTIV EPOC TESTBENCH (LABVIEW VERSION)

Total | FFT | Gyro | Guerdaren CSV |

Instrucciones para ver las sefiales: Path del edkdll

1. Antes de gjecutar el programa seleccione la ruta de acceso b G edkdll E‘
2. Ejecute el programa
3. Presione "Stop" para parar la adquisicién de EEG
EEG data ol

= /] 1500

ED_F7 - 1400~

wr 1300+

ercs N 1200+

.17 m 1100-|

o BM 1000

oo N :227

mo: Il j: —y

I ] EL -

e B T -

e Fcs [N 400-

VI ] 300-|

mr 200-

B ] 100+

0-
-100-1
-200-} i

36220 31243

Figura 28: Panel frontal de la aplicacion EEG

El diagrama de bloques correspondiente se compone de diferentes funciones
comunes de LabVIEW, ademas de las correspondientes a la libreria del Emotiv Toolkit. Con

todo ello, tomara la siguiente forma:
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ULL

Ruta edk.dll
& L hedk.dll

80

EmoEngine ~

@W

|=>—{h05 11 [EEG data

4000

EEG data

b ActPlot
Plot.Mame

Figura 29: Diagrama de bloques de la aplicacion EEG

FFT (Fast Fourier Transform)

Esta parte del programa corresponde a la obtencién del espectro de la sefial EEG
proporcionada por cada electrodo del dispositivo. La visualizacion del espectro sera util para
el estudio de los diferentes ritmos cerebrales: Delta, Theta, Alpha y Beta. Cada ritmo se
corresponde con un rango de frecuencias diferente de cada sefial, como se ha explicado en

apartados anteriores.

. Ritmos Delta: entre 1y 4 Hz.
o Ritmos Theta: entre 4y 7 Hz.
J Ritmos Alpha: entre 7y 13 Hz.
o Ritmos Beta: entre 13 y 25 Hz.

En este apartado resulta posible estudiar ademas las amplitudes que presenta la sefial
EEG correspondiente a cada electrodo durante el tiempo, los cuales se referencian cada uno
con un canal diferente. Para la clasificacion de las magnitudes del espectro de cada sefial en
los correspondientes ritmos mencionados, se han utilizado filtros de tipo Pasa Banda, de

tipologia Butterworth de orden 3.
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Se han colocado indicadores numéricos en forma de tanque de llenado que indican
el valor maximo que alcanza la magnitud del espectro de la sefial EEG de cada electrodo en

el tiempo.

De esta manera, el panel frontal de la aplicacion destinada a la adquisicion de las sefiales
en el dominio de frecuencias para el estudio de los diferentes ritmos de potenciales del

cerebro se presentara de forma similar a como se muestra en la figura 30.

EMOTIV EPOC TESTBENCH (LABVIEW VERSION)

Total  FFT ‘ Gyro | Guardar enCsV |

Canal Canal Individual e %

“l(”“ W (‘W““N‘U)l\;““lm‘l‘ ’W i

-30-} d
Canales: 36220 37243

3-AB 7-T 11-P8 15-F8
g = By e

Espectro FFT Collected (FFT - (Peak]) E@N
slrs tooor wire =

Delta Theta Alpha Beta Personalizada
0 - 50+

NSNS a3 G

0,454742 0,0490374 2.89389 385852 0,454742

Figura 30: Panel frontal FFT

El diagrama de bloques de la aplicacién FFT se afiadira al bucle while comdn con la
aplicacion EEG explicada anteriormente con el fin de que puedan reciclarse algunas

funciones de LabVIEW comunes a ambas.
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Figura 31: Diagrama de bloques de la aplicacion FFT

GYRO

En este mddulo se consigue la visualizacion gréfica de la aceleracién rotacional de
la cabeza del sujeto sobre el eje horizontal y el eje vertical por separado. Para que esto sea

posible, se ha implementado una funcién index array para cada eje.

En el caso del eje horizontal, el indice del index array corresponde al nimero 17 del
array de dos dimensiones que proporciona el EEG Data.vi; en el caso del eje vertical, el
indice se corresponde con el numero 18. Ademas de ello, se han usado filtros de tipo Pasa

Alta para filtrar las frecuencias menores a 0,1 Hz.

Cuando el sujeto realice movimientos de negacion con la cabeza, éstos se realizaran
sobre el eje X, por lo que se visualizard una sefial de amplitudes mayores en la gréfica
correspondiente a la aceleracion rotacional sobre el eje horizontal. De igual manera ocurrira
cuando el sujeto realice movimientos de asentimiento, los cuales quedaran reflejados con
sefiales de mayores amplitudes en la gréafica correspondiente a la aceleracion rotacional sobre

el eje vertical.

El panel frontal para la visualizacién de las correspondientes formas de onda tendra

el siguiente aspecto:
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EMOTIV EPOC TESTBENCH (LABVIEW VERSION)

Total | FFT Gyro ‘ Guardaren CSV |

Este modo muestra la aceleracién rotacional de la cabeza en los diferentes gjes.

GYROX  Muestra la seiial producida por el movimiento en el eje horizontal ec AN
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GYROY  muestra la sefial producida por el movimiento en el eje vertical ]
500 -
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Figura 32: Panel frontal de la aplicaciéon GYRO

De esta manera, el diagrama de bloques que se implementara en el interior del bucle
while comun resulta ser de la siguiente manera:

i** HiahEass "'I

GYROX
17 o F = L4
17 ] o1 E
0.05
i*r HiahEass "I
é@ o 1 GYROY
= 01| { =

0,05

Figura 33: Diagrama de bloques de la aplicacion
GYRO
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GUARDAR EN CSV

El diagrama de bloques de este apartado ha sido facilitado por la empresa canadiense
MusaelLab®©, dedicada a la investigacion en el campo de la ingenieria biomédica y
telecomunicaciones, especificamente en el procesamiento de sefiales para comunicaciones
multimedia, diagndsticos de salud y la interaccién hombre-maquina. Es por ello que, debido
a la complejidad del diagrama, se explicara su funcion principal y algunos detalles sobre los
elementos que de los que se compone.

Este apartado del programa se encarga de aportar las herramientas necesarias para
guardar los datos de las sefiales EEG adquiridas durante un tiempo determinado en un
archivo de formato *.CSV externo a LabVIEW, de manera que estas sefiales puedan ser
estudiadas en otros programas de procesamiento comerciales, como por ejemplo en Matlab.
Ademas, permite enviar marcas durante la adquisicion de las sefiales EEG que quedaran
reflejadas en el archivo de guardado, lo cual resulta atil para facilitar el estudio de las sefiales
en puntos determinados deseados de las mismas.

Para poder guardar los datos sera por tanto necesario en primer lugar la creacion de
un archivo con extension *.CSV. Para ello, basta con crear un archivo de hoja de célculo,
como puede ser por ejemplo en Microsoft Excel, y guardarlo con el formato deseado en este

Caso.

Una vez creado el archivo, el siguiente paso consiste en indicar su ruta de acceso en
el lugar del programa en LabVIEW habilitado para tal fin. Para ello, debe seleccionarse con

el mouse el icono en forma de carpeta en el programa y elegir la ubicacion del archivo CSV.

El panel frontal dedicado al guardado de los datos EEG en formato CSV tendra el

aspecto de la figura 34:
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EMOTIV EPOC TESTBENCH (LABVIEW VERSION)

Total | FFT | Gyro  Guardar en CSV ‘

Instrucciones para guardar las sefiales:

1, Antes de ejecutar el programa corrija la ruta de accese
2. Escoja el archivo CSV donde desee guardar los datos
3. Ejecute el programa

4. 5i desea algun marcador pulse "Send Marker"

5. Presione "Stop" para parar la adquisicion de EEG

Save EEG data
1000~

Amplitude

m
=
o
3

S
2

Ubicacion del archive CSV

% C:\..\Datos EEG.CSV

_/ Reading Emotiv

STOP

( I,) Marker

Samples

Tiempo de muestree
(ms)

Figura 34: Panel frontal de la funcion Guardar en CSV

El diagrama de blogues correspondiente al guardado de datos EEG en formato CSV

es el que se presenta a continuacion, en la figura 35:

Path del edidll | =] brlstatus] [ #stop 2]
L -
" —

EE_InputChannels_enum

4

(]

Height "
Width ¥
Humitems ¥
RingText ¥

Stringsl] _ Heoooooooseoos

Ubicacién del archiva CSV

#Far
=

Marker

g

Lectura

stop 2

#elements

[ replace or create v

Emotiv Stop Taskvi

Figura 35: Diagrama de bloques de Guardar en CSV
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El esquema del diagrama de bloques completo para la adquisicion de sefiales EEG en

LabVIEW se encuentra en el Anexo 1l de la presente memoria.

Ademas, se adjunta en el Anexo IV una explicacién mas detallada de los bloques funcionales

de LabVIEW que intervienen en la creacion del diagrama de bloques del programa elaborado.
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2.2. Disefio en EEGLAB

Esta se trata de una aplicacion desarrollada para el programa Matlab destinada al
estudio de las sefiales EEG en instantes determinados de tiempo y valores de frecuencia de

las mismas deseados.

Matlab es un lenguaje de alto nivel y el entorno interactivo utilizado por millones de
ingenieros y cientificos en todo el mundo. Permite explorar y visualizar ideas, asi como
colaborar interdisciplinarmente en el procesamiento de sefiales e imagen, comunicaciones,

sistemas de control y finanzas computacionales. [25]

Para estudiar las sefiales EEG se utilizard una herramienta interactiva Ilamada
EEGLAB. Esta herramienta esté disefiada para el procesamiento de EEG, MEG y otros datos
electrofisiol6gicos que incorporen el ICA (Independent Component Analisys). Fue
desarrollada en MATLAB 5.3 bajo Linux. Actualmente se puede ejecutar en MATLAB v5
y versiones superiores bajo Linux, Unix, Windows y Mac OS X. Puede ser descargado de

manera gratuita en su pagina oficial. [26]

La pantalla principal de Matlab cuenta con la ventana CommandWindow en la cual
se ingresan los diferentes cddigos de programacion, el WorkSpace es donde se listan las
variables utilizadas y el CommandHistory donde se tiene acceso rapido a los comandos

utilizados.

" MATLAB R2012a - IEE
Fie Edt Debug Desitop Window Help

B9 0| o) B | @ | CumentFolder CUsersiPacheco\Documents\ MATLAE

ow 1o Add (] What's New
=0 fx

“wg e x

-e & B select datato plet =

COMMAND WINDOW

WORKSPACE

COMMAND HISTORY

4 Start Ready

Figura 36: Ventana principal Matlab
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Para empezar a trabajar con EEGLAB solo se necesita ejecutar el comando eeglab

en la ventana CommandWindow.

Esta aplicacion no permite adquirir la sefial EEG a tiempo real, es decir, primero es

necesario guardar la sefial en formato .edf (en el Testbench) para procesarla en EEGLAB y

estudiar lo que el usuario desee.

! No current dataset

EEGLAB v134.3b - o

|| File Edit Tools Plot Study Datasets Help

N

- Create a new or load an existing dataset:

Use "File > Import data” (new)
Or "File > Load existing dataset” (old)

- If new,

“File > Import epoch info" (data epochs)
“File > Import event info" (continuous data)
"Edit > Dataset info” (add/edit dataset info)
"File > Save dataset” (save dataset)

- Prune data: "Edit > Select data”

- Reject data: "Tools > Reject continuous
- Epoch data: "Tools > Extract epochs”
=5 b

line: “Tools > R

-RunICA: "Tools > Run ICA"

Figura 37: Ventana principal EEGLAB

Para leer la sefial se tendran que seguir los siguientes pasos:

e Como se trata de una sefial capturada con un Emotiv Epoc se insertara

mediante: File-> Import data -> Using EEGLAB functions and plugins ->
From EDF/EDF+/GDF files (BIOSIG toolbox)

e Seguidamente saldrd una ventana donde debemos poner los canales que

deseamos ver (Channel list). En principio se pondran desde el 3 hasta el 16

(los 14 electrodos que posee el Emotiv Epoc). Importante: Hay que poner

todos los numeros desde el 3 hasta el 16, el formato 3-16 no es valido.
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Ademas se deberan importar las posiciones de los electrodos. Para ello es necesario

crear un archivo .ced donde estén las coordenadas de cada electrodo. Este archivo se puede

crear en el bloc de notas y se deben afiadir los datos aportados en la figura 38:

£

Canales_Official: Bloc de notas

Archivo Edicién Formato Ver Ayuda

Number labels theta
1 AF3 -23
2 F7 -54
3 F3 -39
4 FCS -69
5 17 -9
6 P7 -126
7 01 -162
8 02 162
9 P8 126
10 T8 90
11 FC6 69
12 F4 39
13 F8 54

radius X Y Z

©.411 ©0.885 0.376 0.276
©.511 ©.587 ©.809 -0.0349
©.333 0.673 0.545 0.5
0.394 ©0.339 0.883 0.326
0.511 6.12e-017 ©.999 -0.0349
©.511 -8.587 ©.809 -0.0349
©.511 -8.95 ©.309 -0.8349
0.511 -8.95 -0.309 -0.0349
©0.511 -0.587 -0.809 -0.0349
©0.511 6.12e-017 ©.999 -0.0349
©.394 ©.339 -0.883 0.326
8.333 0.673 -0.545 0.5
0.511 ©.587 -0.809 -0.0349

O OoONOTUVE WN

sph_theta sph_phi type
23 16 1
54 2 1
39 30 1
69 19 1
90 -2 1
126 -2 1
162 -2 1
-162 -2 1
-126 -2 1
-90 -2 g
-69 19 1,
-39 30 1
-54 -2 1

Figura 38: Coordenadas de los electrodos

Una vez creado el archivo con las localizaciones de los electrodos éste se debe

importar en Edit -> Channel Locations -> Read Locations. Se seleccionara el archivo y se

cargaran directamente las posiciones como se puede observar en la figura 39.

READ LOCATIONS

Edit channel info -- pop_chanedit() -0 n

Channel information (“field_name"):
Channel label ("label") AF3 Opt_head center
Polar angle ("theta") .22 461 Rotate axis
Polar radius (“radius”) 0.42113 Transform axes
Cartesian X ("X") 76.1528
Cartesian Y ("Y") 314828 Xyz -> polar & sph
Cartesian Z ("2") 20 8468 Sph -> polar & xyz
Spherical honz angle ("sph_theta”) 22 461 Polar -> sph. & xyz
Spherical azimuth angle (“sph_phi”) 14.197
Spherical radius ("sph_radius”) 85 Set head radius
Channel type Set channel types
Reference Set reference
Index in backup ‘urchanlocs’ structure
Channel in data array (set=yes) vl

Delete chan Channel number (of 14)

insert chan__ | < | | 1 | >> | Append chan |

Plot 2-D Plot radius (0.2-1, [J=auto) Nose along +X % Plot 3-D (xyz)

Readlocshelp | Lookuplocs | Save(as.ced) | Save (other types)|

eeamoameoese—

Help _Cancel || Ok |

Figura 39: Channel Locations
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Para comprobar que los electrodos se han importado correctamente estos se pueden
visualizar de dos maneras: por nombre o por nimero. Para ello, es necesario dirigirse a: Plot

-> Channel Locations -> By Name/By Number

)} Figure 2 - o IEN

File Edit | View Inset Tools Desktop Window Help ~
DEdS KM RANDRLAL- G 08| =D

Channel locations

14 of 14 electrode locations shown

Figura 40: Posicion de los electrodos

Una vez configurada la localizacion de los electrodos ya se puede visualizar y

estudiar la sefal EEG.
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2.3. Disefio en OpenViBE

OpenVIBE es una plataforma de software dedicada a disefiar, probar y estudiar
interfaces cerebro-computadora. El paquete incluye una herramienta de disefio para crear y

ejecutar aplicaciones personalizadas.

Se trata de un software que permite el procesamiento en tiempo real de las sefiales
cerebrales. Puede utilizarse para adquirir, filtrar, procesar, clasificar y visualizar las sefiales
del cerebro en tiempo real. Los principales campos de aplicacion de este programa son
médicos (asistencia a personas con discapacidad, biorretroalimentacion en tiempo real,
neurofeedback), multimedia (realidad virtual, videojuegos), robética y otros campos de

aplicacion relacionado con interfaces cerebro-computadora. [27]

En la pagina oficial esta el software para descargarlo directamente de forma gratuita.

Dicho programa tiene dos aplicaciones que se van a utilizar en el presente proyecto:
e OpenVIBE Acquisition Server

Este programa sirve para realizar la interfaz de la Emotiv Epoc con
OpenVIBE. La configuracion es sencilla, lo primero que hay que configurar
es la ruta de la libreria del Epoc (.dll) y seguidamente establecer la tasa de

muestreo a 128.

® Device configuration  [IEM ® OpenViBE Acquisition Server v1.0.1 =

Emotiv EPOC

14 EEG channels i 5 A . 4. Preferencias
128 Hz sampling rate Driver : Emotiv EPOC 17| Driver Properties !

User ID s used for acquisition from multiple EPOC
via different Acquisition Servers on the same computer.
ID starts at 0 for the first headset con
hesdset has ID 1, etc.

Identifier : 0 37

| conectar

Comectionport: [ 1024

Sample count per sent block : | 128

. = Device drift : 0.00 ms
e k2 = (olrance s set 0 2.00 ms)
Gender : male > [

Headset User ID: 0 3?

I Add 2 more channels for gyroscope

0 host connected...

Change channel names |

Path to Emotiv Research SDK

Figura 42: OpenVIiBE Acquisition Server

[T 32 bit

Poner aqui la ruta .dll

& Cancelar |

Figura 41: Driver
Properties
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Una vez conectado solo se necesita activar el disefio presionando el boton play del

OpenVIiBE-designer.

e OpenVIiBE Designer

En este programa es donde se realiza el disefio para obtener los resultados que el
usuario desee. Se basa en una estructura simple de cajetines donde el usuario puede

relacionar los diferentes bloques a su eleccién.

En el presente proyecto se ha utilizado este programa para visualizar los FFT de los
ritmos alpha, beta, delta y theta, asi como un mapeo en 2D y 3D de estos. Se programa la

aplicacion para que realice lo siguiente:

v" Mostrar las sefiales de todos los electrodos
v Mostrar el espectro de cada ritmo

v Visualizar en 2D y 3D la situacion real de los electrodos en la cabeza

A continuacion, se muestra el diagrama de bloques creado (Figura 43)

Signal display
Seiial Electrodos

In|Out|Set

Temporal fiter
[Filtro Butherworth Pa\g[abanda 1-4 HZ (Delta)]

3
Time based epoching
In|Out|Set
5 F

Spectral analysis (FFT)
IV

(Frequency Bgmd Selector)

"7
Simple DSP
InjOut|Set
57
Signal a\ferage
“F
S
Epoch average
In]Out|Set
7

2D topographic map

DELTA 2D

Power spectrum display

DELTA

(Electrode local'swation file reader] (Electrode bcal'swation file reader]

DELTA 3D

Figura 43: Parte del programa que representa Delta
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El filtro creado (Temporal filter) es un Butterworth de orden 4 pasa banda con una
frecuencia de corte distinta para cada ritmo (alpha, beta, delta y theta). La localizacion de

los electrodos es la que viene en las librerias (Openvibe/share/electrode_sets)

Para la visualizacion del espectro se ha afiadido un selector de bandas de frecuencia
(Frequency Band Selector) para que el espectro solo muestre los valores entre el rango de

frecuencia dado.

Los cuatros casos tienen la misma estructura. Solo se deberd cambiar el rango de

frecuencia.

Este programa te permite guardar la sefial en formato .EDF o .CSV utilizando los
blogues llamados EDF File writer y CSV File writer. Para conseguir guardar la sefial es
necesario conectar la patilla de color rosa de cada bloque (signal) con su correspondiente

pestafia en el bloque de adquisicion de la sefial.

El diagrama de bloques completo para la adquisicion y estudio de las sefiales EEG

con sus correspondientes potenciales mediante OpenViBE se encuentra en el Anexo VIII.
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2.4, Disefio en Arduino

En una de las précticas de laboratorio propuestas en el presente documento, se ha
realizado una interfaz para conectar el Emotiv EPOC con un Arduino. Para poder llevar a
cabo dicha accion, se necesita un procesador que recoja las sefiales del aparato y envie los
comandos a la placa. El procesador utilizado se llama “Processing” y es en ¢él donde se
realizara el codigo de programacion. No obstante, este procesador no es capaz de recoger y
procesar las sefiales del dispositivo EPOC, sino que para ello invoca una libreria de una

programa llamado Mind Your OSCs que realice dicho trabajo.

Este programa permite enviar datos desde el dispositivo EPOC como paquetes OSC
(Open Sound Control) hacia otros programas. Se puede descargar de manera gratuita en la
pagina oficial de Emotiv. Para activarlo solo es necesario conectarlo al Control Panel y a
OSC. [28]

i Mind Your OSCs - o IEH

Affectiv

Engagement/Boredom
Cognitiv

Frustration

Meditation

0sC

Excitement Power:

=3

Excitement Long Term

ENES [EHESNES:

5508 Epress | 7300
Blink [~
et Cornact Wink Left [~ winkRight [~ Disconnect Connect

LookLeft [~ LookRight

Raise Brow

| (| e

Furrow Brow

Smile Clench Smirk Leftl Smirk Rightl Laugh

Figura 44: Mind Your OSCs

Processing se trata de un lenguaje de programacion y entorno de desarrollo integrado
de cddigo abierto basado en Java, de facil utilizacion, y que sirve como medio para la
ensefianza y produccion de proyectos multimedia e interactivos de disefio digital. Es gratuito

y se puede descargar en la pagina oficial. [29]
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Finalmente, Arduino es una plataforma de hardware libre, basada en una placa con
un microcontrolador y un entorno de desarrollo, disefiada para facilitar el uso de la
electronica en proyectos multidisciplinares. EI microcontrolador se programa mediante el
lenguaje de programacion Arduino (basado en Wiring) y el entorno de desarrollo Arduino
(basado en Processing). [30]

Para conectar al Emotiv EPOC con Arduino se han elaborado dos programas
sencillos en Processing. El caso 1 consiste en que un led debe encenderse mientras el sujeto
este sonriendo. El caso 2 esta programado para que una serie de leds muestren al usuario el

nivel de meditacion que posee en cada momento.

Los circuitos eléctricos necesarios para la correcta ejecucion del trabajo se muestran
en las Figuras 53 y 54. En el primer caso solo se ha de conectar el led directamente a la placa
Arduino (si es de alta impedancia) mientras que en el segundo caso se le ha conectado una

resistencia entre cada led y la placa con el fin de prevenir sobrecargas indeseadas.

Figura 45: Circuito 1 Arduino Figura 46: Circuito 2 Arduino

En el Anexo V de la presente Memoria se muestra el cddigo comentado de los dos

programas realizados en el procesador.
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Para que Processing conecte con Arduino es necesario cargar la libreria Standard

Firmdata.
sketch_jun28a Arduino 1.6.4 - B
Archivo | Editar Programa Herramientas Ayuda

Nuevo Ctrl+N s ' m

Abrir.. Ctris0 02 Digital ’

Rrpma | 03.Analog 3

Gemplos | 04.Communication * ~

Cerrar Ctrl+\W WBEemi '

Salvar Ctrl+S 06-Sensors ’

Guardar Coma... Ctrl+ Mayiis+5 R g

Subir Crl+U LStrings ’

Subir Usando Programador  Ctrl+Mays+U N '
10.5tarterkit 3

Configurar Pagina Ctrl+Mayis+P ArduinolsP

Irnprimir Ctrl+P
Bridge 4

Preferencias Ctrl+Coma EEPROM >

Salir Ctrl+Q gl g
Ethernet 4
Firmata { AlllnputsFirmata
GSM L| AnalogFirmata
LiquidCrystal ¥ EchoString
Robot Control [ OldStandardFirmata
SD [ ServoFirmata
Servo [ SimpleAnalogFirmata
SoftwareSerial ¥ SimpleDigitalFirmata
SPI [ StandardFirmata
Stepper 4
TFT »

Figura 47: Standard Firmdata de Arduino

Una vez cargada la libreria, y con el MIND YOUR OSCs conectado, el

usuario solo tendra que activar el codigo de Processing presionando el boton “Play”.
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Capitulo 3

Pruebas, analisis y resultados obtenidos

Pégina 64 de 179



JORDAN ORTEGA RODRIGUEZ

Universida i
u LL | de La Lagun: ALEJANDRO PACHECO CANO

3.1. Calibracién bioldgica

El registro de un EEG es muy sensible a las variaciones de potencial que provienen

del exterior y que aparecen en el trazado EEG como artefactos. La mayoria de los artefactos

se reconocen con facilidad cuando uno mismo ha observado durante el registro como éstos

se han originado. Evidentemente pueden crear a veces dificultades de interpretacion debido

a que presentan a veces engafiosas similitudes con potenciales auténticos. Una delimitacion

mas segura se obtiene repitiendo el registro EEG. [11]

Las posibilidades de que se originen artefactos se presentan en la propia persona que

se ha de examinar (artefactos biolégicos), trastornos en el aparato de EEG, influjos eléctricos

externos sobre el paciente y sobre el sistema de registro, asi como sobre los electrodos y las

conexiones.

Se pueden distinguir dos tipos de artefactos: externos e internos. [31]

e Artefactos externos: son los derivados de la maquina de EEG, del

instrumental, o del medio ambiente. Dentro de este apartado, podemos

distinguir:

v’ Técnica inadecuada en la colocacion de electrodos y montajes

v' Alteracion de los pardmetros de calibracién

v Corriente alterna

v Los propios electrodos (deslizamiento, suciedad, exceso o déficit de
pasta conductora)

v' Electricidad estatica

v Defectuosa alineacion de la linea de base

v' Movimientos y pasos en la habitacion

e Artefactos internos: son los derivados del propio paciente. Los mas

significativos son:

v
v
v

Electrocardiograma o marcapasos
Pulso

Respiracion
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v’ Electromiograma o artefacto muscular (tics, temblores, deglucion,
etc)

Contraccion musculos craneofaciales

Parpadeo

Movimientos oculares

Sudor

Movimientos del paciente

AN N NN

Para calibrar biologicamente el Emotiv Epoc se ha decidido realizar una comparacion
entre los artefactos bioldgicos (internos) obtenidos al realizar un estudio sobre un sujeto y
los obtenidos tedricamente en diferentes libros de electroencefalografia. Ademas, como
investigacion para las practicas propuestas posteriormente, se han intentado evaluar
diferentes acciones no descritas en la documentacion de EEG estudiada para ver si existen

otros artefactos bioldgicos que afecten de igual manera a la sefial.

Como se ha mencionado anteriormente hay artefactos externos que no se han podido
controlar. Es por eso que a la hora de verificar los resultados han salido variaciones sin
mucho sentido. Por ejemplo en la siguiente figura, el sujeto estuvo en reposo con los 0jos
cerrados y se ve claramente como aparecen variaciones en tres electrodos (color negro, rojo

oscuro y azul celeste) demasiado agresivas para ese estado.

YA ANy AR Ay A e At A At AN AU bt A S A AR A sy

[Me- e ) . 4 NNt ru sl Al A

I | I
me.-‘»,«-\/wam P LMY YV ER Y 2 PPNV FHERRTIE Y (VI ) RV TR IR TR T

Figura 48: EEG del sujeto en reposo con ojos cerrados
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3.1.1. Test:

Las pruebas realizadas han sido las que se muestran en la siguiente tabla:

Intervalos de tiempo

Tipo de prueba

[minutos]
'Reposo (ojos cerrados) ~~ 0:00-1:30

Ejercicio para pensar 1:30 — 2:40
Contraer musculos de las 2:50 - 3:10
manos

Mover brazos 3:20 - 3:40
Parpadeo constante 3:50 - 4:00
Movimiento ocular 4:10 — 4:20
Recitar el alfabeto al reves 4:30 — 4:45
Reposo escuchando musica 4:50 —5:30
Sonreir 5:35-5:45
Reir 5:50 - 6:00
Guifiar un ojo 6:10 — 6:20

Tabla 3: Pruebas de test para la calibracion bioldgica

Entre cada ejercicio se han dejado unos 5-10 segundos para notar mejor el cambio de
la sefiales. A continuacion se pueden ver los dos ejercicios que se le ha pedido a los sujetos
que realicen durante el minuto 1.30 y el 2.40 del test.

N T o
o1y - {

sy

Figura 49a: Ejercicio 1 para pensar Figura 49b: Ejercicio 2 para pensar

estas figuras.
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3.1.2. Sujetos:

Lo ideal para hacer una prueba de estas caracteristicas es tener sujetos de diferentes
edades para poder hacer un estudio mas preciso. En este caso al no tener autorizacion para
llevar el aparato de electroencefalografia portatil fuera del laboratorio solo se ha podido

evaluar a otros alumnos pertenecientes a la universidad.

- Sujeto 1: Alberto Gutiérrez (Edad 21 afos; Altura 1,74m; Peso 70 kg)
- Sujeto 2: Sergio Heras (Edad 22 afios; Altura 1,75 m; Peso 66kg)

- Sujeto 3: Javier Ledn (Edad 22 afios; Altura 1.69 m; Peso 62kg)

- Sujeto 4: Ainhoa Cruz (Edad 21 afios; Altura 1.66m; Peso 60 kg)

Figura 50c: Sujeto 3 Figura 50d: Sujeto 4
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3.1.3. Resultados:

- ESTUDIO 1: parpadeo

b n A s A b AN A A AA N A A

A [ S e

N‘ f A
t 7 | A A T e R A R o G v oA
I\IW s F st | UL A VUVUUN UMV MAANAAAM S W

JERPR 3 (R SV PP ST TORS EOATTIEY BT N S o
gy [ Y dmaciricoyf gttt et x damis
X e e
P S
o | " st pon 1 A \1‘ J st Pt
R [ T N«M»m.\.wi'mu ,
! Vi 4 1
,,"-4.“.;1 O N OV I ”t' l | A
W ki
"

5B A v i { -
ARSI A AR S

Figura 51c: Parpadeo del sujeto 3 Figura 51d: Parpadeo del sujeto 4

Resultado: Se pueden apreciar los picos W
del parpadeo en cada sujeto. En los casos de los
sujetos 2 y 3 se ve claramente el artefacto NS A

mientras que en los otros dos sujetos la sefial

posee un cierto nivel de ruido. NETTEEENET N et SR

ESTUDIO 1 VALIDO X e e ——
. !
ESTUDIO 1 NO VALIDO []

Figura 52: Forma del parpadeo

[11]
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- ESTUDIO 2: Guifiar 0jos
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Figura 53c: Guifio del sujeto 3 Figura 53d: Guifio del sujeto 4

Resultado: En este caso no ha sido
facil la comparacion ya que en algunos casos
se ha presentado demasiado ruido en la sefial.
Sin embargo en todos los casos se ha podido

apreciar en los electrodos frontales (sefiales 1,

2,5, 10, 13 y 14 de las imagenes) un cambio

| : . :
017 2066 2919 2970 Q024 ¢

brusco como en el de la imagen de ejemplo.

Estos electrodos son los primeros en variar por [N

esta accion debido a su localizacion. Figura 54: Forma del guifio de un
) ojo [32]
ESTUDIO 2 VALIDO E

ESTUDIO 2 NO VALIDO O
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- ESTUDIO 3: Movimiento ocular

POV PPy, NP N e~

i r o

N A T e A

Figura 55a: Movimiento ocular del sujeto 1  Figura 55b: Movimiento ocular del sujeto 2

i
,‘._/ \, J«""”?"'“"‘ A AY, N .'w M-"'“"‘*‘“‘*’*’kp**‘w-l"%'**vm\h"»ﬂ;l«v""“ oy

Figura 55c: Movimiento ocular del sujeto 3  Figura 55d: Movimiento ocular del sujeto 4

Resultado: La forma del movimiento ocular
puede confundirse facilmente ya que presenta unos

pequefios y suaves picos en la sefial. En el estudio

es mas sencillo de distinguirlo ya que se conocia el

intervalo en el que este movimiento ocurria. En este
caso la comparacion coincide pero las sefiales

presentan un pico mas pronunciado que en la teoria.

ESTUDIO 3 VALIDO X
ESTUDIO 3NO VALIDO [

Figura 56: Forma del
movimiento de los ojos [33]
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- ESTUDIO 4: Movimiento muscular

et AN
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Figura 57a: Movimiento muscular del

Figura 57b: Movimiento muscular del

sujeto 1 sujeto 2
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Figura 57c: Movimiento muscular del
sujeto 3

Resultado: La forma del movimiento
muscular presenta una sefial con bastante ruido
en varios electrodos. En las sefiales captadas si
es cierto que en algunos casos se aprecia unos
picos que pueden demostrar el movimiento del
musculo pero no se observa el ruido excesivo
mencionado anteriormente. No consideramos
que las sefales se parezcan lo suficiente.

ESTUDIO 4 VALIDO |

ESTUDIO 4 NO VALIDO X

Figura 57d: Movimiento muscular del
sujeto 4
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Figura 58: Forma del movimiento
muscular [34]
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- ESTUDIO 5: MOVIMIENTO CORPORAL

FYAVESAN, PCAWNEY DAV, caverestiv) M I v
Figura 59a: Movimiento corporal del Figura 59b: Movimiento corporal del
sujeto 1 sujeto 2

it

vr“
i

|

2 ),

Aol h L i | [

[
ol

S
f
!

i, ‘“’“""‘TM"“""" AR
Figura 59c: Movimiento corporal del Figura 59d: Movimiento corporal del
sujeto 3 sujeto 4
Resultado: Este movimiento produce una 5 i o e R L 1 0 e P
p : !

alteracion notable en todos los electrodos. En todos i) } il
los casos, menos en el sujeto 1, se ha notado una gran Bt i Ao s |
W W VR S ‘ g
variacion en la mayoria de los electrodos. i s ) ]
i g e S LS i

ESTUDIO 5 VALIDO X

ESTUDIO 5 NO VALIDO [

Figura 60: Forma del
movimiento corporal [34]
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- ESTUDIO 6: Reposo con y sin masica

La musica es un estimulo que enriquece los procesos sensoriales, cognitivos (c5omo
el pensamiento) y motores, ademas de fomentar la creatividad y la disposicion al cambio. A
partir de diversos tipos de musica se pueden inducir diferentes estados de animo, los cuales
pueden repercutir en tareas psicomotoras y cognitivas. [35] Una de las variables importantes
que intervienen en estos efectos se refiere a la clase de mdsica que se escucha. En este

sentido, existen principalmente dos tipos:

e La estimulante, que aumenta la energia corporal, induce a la accién y
estimula las emociones.

e Lasedante, que es de naturaleza melddica sostenida y se caracteriza por
tener un ritmo regular, una dinamica predecible, consonancia arménica y un

timbre vocal e instrumental reconocible, con efectos tranquilizantes.

En este este estudio se ha querido comprobar si la musica relaja a los sujetos ya que

se les ha reproducido una cancion de Ludovico Einaudi, famoso pianista, llamada Ancora.

\
i el B S e I Y a7 R [ | HAWISSGPUR N SRS SOYSPSUUUNIN PSSV SIS WSSOI IVSUUR I | N
7 G J
o oo SO WSSOI V7 SN . AN Yl b/ S 5 S YAV I VSV ol A

S SRS SmSes 1 IR RSS] SOOI 100 B . e S L T

e AAAAAN A AR A b s Ap ARy e s A NRANANRA A A A AN AN A AR P A A PN A e A NN SNt e A NN AN NN P A

Figura 61a: Reposo del sujeto 1 Figura 62a: Sujeto 1 escuchando musica

A A i St oL b

DRI A S—"

VRPN SR S

Figura 61b: Reposo del sujeto 2 Figura 62b: Sujeto 2 escuchando musica
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Figura 61d: Reposo del sujeto 4 Figura 62d: Sujeto 4 escuchando musica

Resultado: No se puede apreciar bien que haya similitud entre las sefiales de los
cuatro sujetos. En algunos parece que realmente si se atendan las sefiales al reproducir la
masica (sujeto 1 y sujeto 4) pero en los otros casos se aprecia una alteracion en las sefiales,
las cuales pueden ser producidas por los estimulos producidos al escuchar la melodia. Aun

asi, se ha definido este estudio como no concluyente.

Otra opcion para evaluar este caso seria el estudio de los ritmos de las frecuencias
(alpha, beta, delta y theta) ya que un estudio realizado por varios cientificos asiaticos,
demostro por medio del registro de EEG y PET, que durante la escucha de mdsica se da un
aumento en la presencia de la banda Beta en la parte posterior de la corteza cerebral. Esto lo
relacionaron con la interaccion de la musica con procesos cognitivos, tales como recuerdos

0 iméagenes visuales evocados por la musica. [36]

ESTUDIO 6 VALIDO (|

ESTUDIO 6 NO VALIDO X
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- ESTUDIO 7: Sujeto resolviendo ejercicios de pensar

En este estudio se ha querido evaluar si un sujeto varia su sefial EEG al resolver una
serie de ejercicios mentales sin utilizar el habla y posteriormente utilizandola. En el primer
caso se le ha dado a los sujetos un libro de ejercicios y en el segundo caso se les ha pedido

que reciten el alfabeto al reves.
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Figura 63b: Pensamiento del sujeto 2 Figura 64b: Sujeto 2 hablando y pensando
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Figura 63c: Pensamiento del sujeto 3 Figura 64c: Sujeto 3 hablando y pensando
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Figura 63d: Pensamiento del sujeto 4
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Figura 64d: Sujeto 4 hablando y pensando

Resultado: Lo primero que se debe mencionar es que comparando con el estado en

reposo, se observa que cuando el sujeto se concentra, la forma de las sefiales varia. Una sefial

EEG no cambia su sefial al utilizar las cuerdas vocales para hablar, la cambia al pensar en la

pronunciacion de una palabra. [37] En este caso se aprecia una clara diferencia con respecto

a las sefales donde el sujeto solo esta pensando para realizar el ejercicio.

Por lo tanto en este estudio se comprueban dos cosas:

ESTUDIO 7 VALIDO

Las sefiales EEG varian entre el estado de reposo y el estado de pensamiento.

El habla influye sobre las sefiales EEG.

ESTUDIO 7 NO VALIDO [0
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- ESTUDIO 8: Sonrisa

En este estudio no se pretende comparar los resultados con ningun otro. La
finalidad es determinar si al sonreir se produce un artefacto diferente a los vistos
anteriormente para poder aplicarlo en la practica de laboratorio 1 “Aplicaciones practicas y
andlisis de la adquisicién de sefiales EEG en tiempo real”, la cual se encuentra en el Anexo

Il de la presente memoria.

SR U SIS UV ISV SR SOWAT TR I I TR B N T e T V A\ oA e ,“_/___.N,»V_,k,.u‘( N T s b *«.:4’- I, i
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Figura 65a: Sujeto 1 sonriendo Figura 65b: Sujeto 2 sonriendo
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Figura 65¢: Sujeto 3 sonriendo Figura 65d: Sujeto 4 sonriendo

Conclusién: Se puede ver como el Emotiv Epoc detecta las sonrisas sin ningun tipo
de problema. Esta accion produce un pico de bastante amplitud en la sefial seguido de un

pico en la mayoria de los casos de igual tamafio.
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3.1.4. Conclusiones generales:

Se han podido comprobar con éxito 5 acciones en las cuales el Emotiv Epoc ha
representado las sefiales con la correcta forma. Es cierto que se ha dado el caso en dos
estudios en el que los resultados no han sido los esperados pero también hay que tener en
cuenta nuestro bajo nivel de conocimientos de esta materia y puede ser que un medico o una
persona mas capacitada si vea los cambios necesarios para dar por buenos dichos estudios.
Ademaés hay que afadir el poco tiempo de duracion de la prueba ya que normalmente estos

test duran entre 30-45 minutos.

Cabe que mencionar que en el test existia otro estudio en el cual se le pedia a los
sujetos que se rieran. No se ha mostrado este estudio ya que al reirse una persona realiza
movimientos con la cabeza y solo se ve ruido en las sefiales, como se puede ver en la

siguiente figura.
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Figura 66: EEG de un sujeto riéndose

En esta calibracion se pretendia observar si las sefiales emitidas por el aparato
electroencefalografico reaccionaban a las diferentes situaciones dadas. Los resultados

obtenidos han sido favorables y se puede dar por bueno el estado del aparato en este aspecto.

En el Anexo VII se pueden observar las imagenes con mayor detalle.
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3.2. Calibracion electronica

En este caso se ha pretendido realizar una calibracion electronica del dispositivo
EMOTIV EPOC en el Servicio de Electronica de la Universidad de La Laguna, de manera
que mediante una serie de sefiales generadas por un calibrador, éstas puedan ser utilizadas
para estudiar algunas de las caracteristicas electronicas del equipo, como puede ser su ancho
de banda o las amplitudes méaximas de la sefial de entrada permitidas para la correcta

adquisicion de las mismas segun la conductancia.

Debido a la complejidad que supone generar sefiales de valores de amplitud y
frecuencia tan pequefios y a las limitaciones de recursos y equipos con los que se ha contado
para llevar a cabo esta tarea, los resultados de la calibracion electrénica del aparato han sido

desfavorables y poco concluyentes.

Estos resultados quedan reflejados en el Anexo VI de la presente Memoria a modo
indicativo. Es por ello que este apartado puede sugerirse para trabajos futuros sobre el equipo
de adquisicion EMOTIV.
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3.3.  Adquisicion de sefiales EEG en LabVIEW

Una vez establecida adecuadamente la comunicacion entre el dispositivo EMOTIV

EPOC y LabVIEW, puede comprobarse en los respectivos paneles frontales de cada

aplicacion disefiada el prefecto funcionamiento de los mismos. En el programa pueden

distinguirse por separado las cuatro funciones elementales para las cuales se ha disefiado:

Visualizacion de las sefiales EEG correspondientes a cada uno de los catorce
electrodos de medida.

Representacion de estas sefiales en el dominio de la frecuencia con su
correspondiente clasificacién en bandas de frecuencia para el estudio de
potenciales en el cerebro humano.

Visualizacion gréfica de la aceleracion rotacional de la cabeza sobre el eje
horizontal y sobre el eje vertical.

Posibilidad de guardar los datos producto de la adquisicion para un estudio

maés detallado de las sefiales EEG durante intervalos de tiempo deseados.

En el apartado EEG del programa se pueden visualizar las sefiales correspondientes

a cada electrodo colocados sobre el cuello cabelludo de un usuario. Esta visualizacién se

trata de una grafica general en la que es posible ver todas las sefiales al mismo tiempo.

e Y
o B
0nrs B
eorcs NG
RV .|
o B
ot %
o2 M
ees N
s
eo oo NG
or M
e N
eo_ars NG

Amplitude

-200 -7 g
64104 65127

Figura 67: Visualizacion de las catorce sefiales EEG
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Esto hecho puede resultar una dificultad a la hora de estudiar las amplitudes de cada
una de ellas en caso de que se requiera. Para ello, se habilita en el apartado FFT (Fast Fourier
Transform) una grafica de visualizacion de cada canal por separado, como se muestra en la
figura 68, ejemplo de visualizacion de la sefial transmitida por el canal correspondiente a
AF3.

ﬂ, d‘l |

Amplitude
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Figura 68: Visualizacion de cada canal por separado. Ejemplo del canal AF3

En el apartado FFT (Fast Fourier Transform) se visualiza ademas el espectro
de la sefial producida por cada canal seleccionable. De este modo es posible estudiar las
sefales en el dominio de la frecuencia.
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Figura 69: Espectro de la sefial del canal AF3

Gracias a la transformada de Fourier para la visualizacion del espectro de cada sefial,
es posible discriminar las mismas en los cuatro ritmos bioldgicos o potenciales del cerebro
presentes en diferentes fases de la actividad cerebral. Para ello se filtra el espectro de cada
sefial entre cuatro rangos de frecuencias correspondientes para visualizar la magnitud del
espectro en cada banda. En este caso, el sujeto tomado para ilustrar este ejemplo se
encontraba despierto y con los ojos abiertos, es por ello que la banda que mas predomina, es

decir, cuyo valor maximo de magnitud del espectro es mayor, es Beta, como se aprecia en

la figura 70.
Delta Theta Alpha Beta Personalizada
50+ 50_: 50': 50': 50; Frec. de Corte Inferior
a5- 45° a5° 45° 452 L
E Frec. de Corte Superior
40- 40= 402 40= 40= A
: E 5 E 4
35- 355 352 355 352
30- 30- 30- 30- 30=
25- 25- 25- 25- 25-
20— 20~ 20- 20~ 20~
15- 15- 15- 15- 15=
10- 10- 102 10- 10
0- 0: o | 0” s
0,0718634 0,0838453 2,09003 4,98392 0,0718634

Figura 70: Potenciales del cerebro humano. Valores maximos de magnitud de espectro en
cada rango de frecuencia
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En el apartado GYRO pueden visualizarse las graficas correspondientes a las
sefiales de la aceleracion rotacional de la cabeza del sujeto respecto del eje horizontal y del
eje vertical por separado. Esto es, cuando el sujeto haga un movimiento de asentir con la
cabeza, predominara la sefial correspondiente al eje vertical y cuando haga un movimiento
de negacién predominara la sefial correspondiente al eje horizontal. Puede apreciarse en la

siguiente figura como el sujeto primero niega con la cabeza y a continuacion asiente.
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Figura 71: Sefiales producidas por la aceleracion rotacional de la cabeza

El apartado GUARDAR EN CSV permite, como su propio nombre indica,
guardar los datos EEG obtenidos a partir de la adquisicion de sefiales para un posterior
estudio con mayor detenimiento usando otros programas que permitan visualizar las graficas
de forma estatica si asi se desea. Mientras el programa en LabVIEW se encuentra en
funcionamiento, al darle al boton STOP la adquisicion de sefiales finalizard y se guardaran
estos datos en un archivo en formato CSV.
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3.4. Practicas de laboratorio

3.4.1. Aplicaciones précticas y analisis de la adquisicion de sefiales EEG en

tiempo real

El objetivo de la presente practica es la adquisicion, familiarizacion y estudio de
sefiales de electroencefalografia (EEG) en tiempo real ante estimulos expresivos del sujeto.
Para ello, se hard uso de un equipo de adquisicion dispuesto de sensores para tal fin, el
EMOTIV EPOC, y del software LabVIEW de desarrollo para disefiar sistemas, con un
lenguaje de programacion visual grafico que permite visualizar el comportamiento en tiempo

real de las sefiales citadas.

Se pretende conseguir la forma de las sefiales EEG producidas como respuesta a

estimulos expresivos concretos, que seran:

- Parpadeo constante
- Sonreir
- Movimiento de cejas

- Fruncir el cefio

Estas sefiales seran comparadas con casos reales de pacientes que han sido ya
estudiados, con el fin de obtener unos resultados similares. Asimismo, se estudiaran algunas
caracteristicas de las sefiales correspondientes a cada caso, como pueden ser sus amplitudes

maximas y minimas.

Es importante saber que en el registro EEG normal aparecen artefactos, que son
alteraciones en las sefiales que se deben a mdltiples causas (movimientos musculares,
oculares, respiracion, pulso, electrodos, resistencia de la piel, sudor, problemas técnicos) y

no significa que haya patologia.

El registro de un EEG es muy sensible a las variaciones de potencial que provienen
del exterior y que aparecen en el trazado EEG como artefactos. La mayoria de los artefactos
se reconocen con facilidad cuando uno mismo ha observado durante el registro como éstos

se han originado. Evidentemente pueden crear a veces dificultades de interpretacion debido
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a que presentan a veces engafiosas similitudes con potenciales auténticos. Una delimitacion

mas segura se obtiene repitiendo el registro EEG.

Las posibilidades de que se originen artefactos se presentan en la propia persona que
se ha de examinar (artefactos bioldgicos), trastornos en el aparato EEG, influjos eléctricos
externos sobre el paciente y sobre el sistema de registro, asi como sobre los electrodos y las

conexiones [11]. En la siguiente imagen se muestran algunos ejemplos.

Artefactos biolégicos:

ol
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1. Parpadeo

2. Actividad muscular al tragar
3. Sudoracion

4. Mouvimicntos de las oicrnas
5. Marcapaso cerdiaco

5. Temblor.

Figura 72: Artefactos bioldgicos. [11]

LabVIEW posee unas librerias con las que se puede realizar la interfaz de este con
los archivos ya mencionados y se forma, formandose una dependencia con el programa

Control Panel.

En este Trabajo se ha utilizado una libreria especifica para la EMOTIV que realiza esta

interfaz.

Para empezar a utilizar la libreria, es necesario tener en cuenta los siguientes vi para

conseguir una correcta interfaz.
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9. EmotivCreate Task.vi: en este vi se debe ubicar la direccion del archivo edk.dll y
colocar el path del subvi.

10. EmotivStart Task.vi: se utiliza para iniciar la interfaz.

11. Estructura while: aqui se programa lo que se desea realizar.

12. Emotiv Read.vi: dentro del bucle while, se utilizara para estudiar las acciones
cognitivas deseadas.

13. Emotiv Stop Task.vi: se utiliza fuera del bucle while para establecer la interfaz.

14. Error out: se utiliza para visualizar un error en caso de que se interrumpa la

dependencia.

El diagrama de bloques tendra la misma estructura para cada accion expresiva que se
desee estudiar y sera el que se muestra a continuacion utilizando las diferentes funciones

incorporadas en la libreria Emotiv ToolKkit descritas anteriormente:

Emotiv Read.wvi

Emotiv Stop Task.wvi

9, Chedk.dll Emotiv Create Task.wvi  Emotiv Start Task.vi
ruta edk.dll (1) :E,& e

EmoEngine

error out

2 = o
= =

Smile *

stop

| z1ar 3
m LTFL

Figura 73: Diagrama de bloques para el estudio de acciones expresivas en LabVIEW

Una vez realizada la interfaz, puede utilizarse el subvi Emotiv Read.vi para estudiar
el comportamiento de las sefiales EEG ante acciones cognitivas o expresivas. Si por ejemplo
se selecciona la opcién Smile, al ejecutar el programa se obtendra un pulso positivo cuando

el dispositivo de electroencefalografia detecte que el sujeto esta sonriendo.

Para que esto pueda ser comprobado visualmente de forma mas sencilla, se colocara
un indicador booleano luminoso (true o false) en el programa que se encendera en el
momento en el que se detecte el pulso positivo. De esta manera, el bucle se presenta del
siguiente modo en cuatro casos correspondientes a cada accidén expresiva concreta que

pretende estudiarse:
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» Parpadeo constante » Sonreir
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100 0000000000000
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500

4 00 0O O 2[0“317 pooouon
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=

Furrow =

100000000000 0000

Figura 74: Diagrama de blogues correspondiente a cada accion expresiva en LabVIEW

Para el correcto estudio de la reaccion del sistema nervioso ante acciones cognitivas
0 expresivas, se aporta la visualizacion de las sefiales EEG de los catorce electrodos usados.

Para que esto sea posible, ademas de los vi mencionados anteriormente se hace uso de los

siguientes:

e EEG Data Start.vi: identificador de datos que se utiliza para proporcionar acceso a

los datos de EEG. antes de la recogida de datos, se Inicializa un bufer.

e EEG Data Acquire.vi: inicia la recuperacion de los ultimos datos EEG existentes en
el bufer. Ademas, se define el nimero de muestras de datos disponibles, las cuales

se utilizan para crear un bufer de datos de ingreso.
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Una vez presentado el entorno grafico de programacion, se pretende profundizar en
el estudio de la variacion de las sefiales EEG ante estimulos cognitivos o expresivos. Es por
ello que en primer lugar se realizara la obtencion practica a tiempo real de dichas sefiales
ante la accién de artefactos bioldgicos concretos, con el fin de que puedan ser comparadas
con registros originales del mismo tipo de artefacto en cada caso. Para ello, se aportan los
registros de varios usuarios como ejemplo previamente estudiados antes las diferentes

acciones expresivas propuestas.

» Parpadeo

EEG data HiEwl
N ] =
oF B
N0 .|
eoFcs AN
ED_T7
ED_P7
ED_O1
ED_02
ED_P2
ED_T8

ED:F& /]

-300-7 i
12688 13711
Samples

Movimiento Fruncir el
de cejas cefio

AE3 | AFL gt
i CP? 9 i3
‘@ | @
@M rcs TC6 (@

Parpadeo Sonriendo

Figura 75: Ejemplo de EEG ante un parpadeo constante

> Sonreir

EEG data R

d
20748 21
Samples

Movimiento Fruncir el
de cejas cefio

@ "

Sonriendo

Figura 76: Ejemplo de EEG ante la accion de sonreir
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» Movimiento de cejas

EEG data g wm|
eo.ar: 0%
ED_F7
=0 -]
enFcs BN
ED.T7
ED_P7
ED_O1
ED_02
ED_P8

error out 2
status  code

;;;;;;

Amplitude

Samples

N Movimiento Fruncir el
Sonriendo SRS cdfib

® O 9

Figura 77: Ejemplo de EEG ante la accion de mover las cejas

> Fruncir el cefio

EEG data Ba =kl
e [N
oF
NI |
e rcs [N
ED_TT
ED_PT
£D_O1
ED_O2
ED_P2
ED_TE
e Fco IRV
oF
mrs
e0_ar4 NG

5
STOP Samples

Sonriendo

eror out 2

\status  code

L 0

| source

gggdgy {

Amplitude

Movimiento Fruncir el
de cejas cefio

® O J

Figura 78: Ejemplo de EEG ante la accion de fruncir el cefio

En el Anexo I, primer apartado, se encuentra el guion de esta practica para el

alumno.
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3.4.2. Andlisis de sefiales EEG con EEGLAB

Una vez configurada la localizacién de los electrodos ya se puede visualizar y

segmentar la sefial EEG. Para poder ver la sefal:

e Plot -> Channel Data (Scroll)

e Se pueden utilizar los signos +/- para cambiar la escala de la sefial y las
flechas para navegar a lo largo de ella. No es necesario visualizar los 14
electrodos para poder segmentar la sefial pero si deseamos verla completa hay

dos formas de solucionarlo:

v/ Cambiando la escala hasta poder ver todos los electrodos. Esto tiene

un problema ya que no se aprecia los cambios de las sefiales.

REECT

Figura 79: Visualizacion de las sefiales 1

v Podemos visualizar los canales de 7 en 7 o en el rango que se desee

en: Settings -> Number of channels to display

ik

Figura 80: Visualizacion de las sefales 2
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e Para guardar una parte de la sefial: Edit -> Select Data-> Time Range

Si se desea eliminar las tendencias ascendentes o descendentes se puede eliminar la
linea base de las sefiales (offset) mediante Tools -> Remove baseline. Es importante saber
que las figuras con la linea de base, tienen una potencia mucho mayor que a las que se les

suprimio ya que la linea de base representa un valor promedio en cada una de las sefiales.

Para poder representar los espectros de la potencia es recomendable realizar un
analisis de componentes independientes (ICA). Se ejecuta de la siguiente manera: Tools->
Run ICA. Finalmente para representar los espectros habra que ir a: Plot -> Channel spectra
and maps. Se suele establecer en las frecuencias a representar los valores medios de las
bandas alfa, beta, delta y theta (2, 6, 10, 21).

Power 1070g, (W */Hz)

Figura 81: Andlisis de potenciales cerebrales en
determinadas frecuencias

Si se desea eliminar parte del registro solo hay que seleccionar esa parte y presionar
reject en la grafica de los 14 electrodos.

o

Figura 82: Parte seleccionada Figura 83: Senfales con la parte eliminada
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Existen diversas funciones en EEGLAB como:

EEGLAB v134.3b
File Edit | Tools | Plot Study Datasets Help
#: Change sampling rate
Filter the data 4
Filenz Re-reference
Chant Interpolate electrodes
Fram( Reject continuous data by eye
Epoc Extract epochs
Event :
Remove baseline
Qamr
Figura 84: Re-reference
EEGLAB v134.3b
File Edit | Tools | Plot Study Datasets Help
#1: Change sampling rate
Filter the data »
Filenz Re-reference
Chani Interpolate electrodes
Fram Reject continuous data by eye
Epac] Extract epochs
Event

Qamr

Remove baseline

Figura 85: Change sampling rate

#1:

Filenz
Chani
Framt
Epocl
Event

Qamr

Figura 86: Reject continuous data by eye

EEGLAB v134.3b

File Edit | Tools | Plot Study Datasets Help

Change sampling rate

Filter the data

Re-reference

Interpolate electrodes

Reject continuous data by eye
Extract epochs

Remove baseline

_ o R

Re-reference: Esta funcion permite tomar otro canal de

referencia y darle valores

Change sampling rate: Es la velocidad de muestreo, asi
que si originalmente tiene dado 1000/s y se lo cambiamos

a 10 (demostrativo) la calidad serd menor

Reject continuous data by eye: Se pueden quitar partes

de la sefial que no son de interés

En el Anexo I, apartado 2, se encuentra el guion de esta practica para el alumno.
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3.4.3. Adquisicion de sefiales EEG vy potenciales cerebrales con OpenViBE

Para visualizar los resultados en OpenViBE en necesario presionar el boton Play del

OpenVIiBE Desisgner. Seguidamente apareceran las graficas programas.

En primer lugar aparece una grafica de la sefial EEG de los 14 electrodos del Emotiv
EPOC. Ademaés aparecen los espectros y los mapeos (en 2D y 3D) correspondientes a los

distintos ritmos Alpha, Beta, Delta y Theta.

Cada filtro Butterworth se ha programado en funcién al rango de frecuencia de cada
ritmo. También se ha afiadido un selector de banda de frecuencia para atenuar la sefial ya
que al reproducir el espectro se observa que el filtro no corta especificamente en el rango

deseado. No existe un filtro ideal que corte en el rango de frecuencia establecido.

A continuacion, se pueden observar las graficas de los diferentes ritmos cerebrales.

® DELTA = L] THETA = ) ® ALPHA =00 L BETA =i
by DELTA I R THETA I X ALPHA I EETA
1:4F3 ues L 1:4F3 Ius N
2:F7 g g 2:F7 d 2:F7 Ah
3 iF iF
3:F3 £ 3:F3 3:F3 = i
: 4 4
4-FC5-II 8 an s R .
577 | g, 5:77 a 5:77 La ..—‘...‘.‘
-] 6:77 | 6:P7 an v] 677 I =
0369 12 16 20 24 28 32 3% 0 36 9 12 16 20 24 B 32 % 0 369 12 16 20 249 28 32 % 12 15 18 21 24 27 0 33 ¥
® DELTA 2D - o ® THETA 2D -0 ® AlPHAD - O ® BETA 2D =l

DELTA 20 I

| e

i
® parazo - “HEM e

DELTA 20

Figura 87: Resultados del programa OpenViBE

Tanto la figura 3D como la 2D se puede rotar y ajustar a las preferencias del usuario.
No se ha mostrado la grafica de los 14 electrodos pero al estar programada también aparecera
en las gréaficas finales. En el Anexo 11, apartado 3, se encuentra el guion de esta practica para

el alumno.
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3.4.4. Interfaz EMOTIV EPOC - Arduino

Una vez realizado todo el procedimiento se deberia comprobar que el Arduino

responde a las acciones programadas.

El primer caso estad programado para que un led se encienda al sonreir el sujeto. El
Emotiv EPOC enviaa MIND YOUR OSCs los valores de Smile los cuales son interpretados
por Processing. Hasta que la sonrisa no emita el valor maximo (1,00) el led no debera

encenderse.

Figura 88: Usuario en estado
de reposo

Figura 90: Usuario sonriendo Figura 91: Led encendido
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En el segundo caso se ha programado un indicador del estado de meditacion de un
sujeto. Se ha establecido una serie de valores para activar cada led:

Ultravioleta >0.15
Azul >0.36
Verde >0.41
Amarillo >0.47
Naranja >0.55
Rojo >0.66

Tabla 4: Valores establecidos para activar cada led

Es complicado alcanzar el estado maximo de meditacion ya que siempre influyen
aspectos que no se pueden controlar (ruidos, olores, sensacién térmica, etc.) por lo que se ha
decidido que el valor maximo del indicador sea 0.66

L T T L T P LI e
0 5 10 15 20 25 30

Figura 92: Nivel de meditacion bajo

—|llll|lll||lllllllll|Illl|llll|
0 5 10 15 20 25 30

Figura 94: Nivel de meditacion medio

Figura 95: Varios leds activos
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0 5 10 15 20 25 30

Figura 96: Nivel de meditacion alto Figura 97: Todos los leds activos

En el Anexo I, apartado 4, se encuentra el guion de esta practica para el alumno.
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Conclusiones
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4. Conclusiones

En el transcurso y la realizacion del presente Trabajo de Fin de Grado se han podido
poner en préctica los siguientes aspectos.

e Se ha comprobado que el equipo de electroencefalografia portatii EMOTIV-EPOC
permite una amplia gama de aplicaciones no solo en el campo de la medicina, sino en
otras areas de estudio cientifico.

e EIl software disefiado y probado en el presente TFG permite realizar las mismas
funciones que trae el kit comercial del propio dispositivo EMOTIV, con la ventaja de
que se trata de un software abierto y sin restricciones de licencia, cuyo funcionamiento
ha sido verificado con éxito por el Dr. Jesus Llabrés Olmo, antiguo Jefe clinico de
neurologia del Hospital Universitario de Canarias.

e Ademas de las funciones que traia el kit comercial, se ha afiadido la posibilidad de
representar potenciales cerebrales sobre modelos de una cabeza humana en dos vy tres
dimensiones lo cual facilita en gran medida el estudio de las sefiales EEG sobre el
paciente.

e Se ha implementado un software sobre Matlab que facilita el analisis en detalle de las
sefiales EEG registradas.

e Se ha realizado una interfaz de comunicacion entre el dispositivo EMOTIV vy la placa
electrénica Arduino, de tal forma que las sefiales EEG interactian con la placa
electronica permitiendo visualizar en ella estados: afectivos y expresivos

e Ha sido posible la verificacion con éxito en las sefiales EEG registradas, numerosos
artefactos biologicos como: el parpadeo, el movimiento ocular y otros. Estos artefactos
alteran la sefial EEG y es imprescindible su correcta deteccion para el adecuado
procesamiento de las sefiales. Se han comparado los resultados obtenidos con la
bibliografia existente.

e Se ha verificado que el dispositivo de electroencefalografia portatil estudiado, Emotiv
Epoc, permite una gran variedad de aplicaciones. Se abre por tanto una amalgama de
nuevas posibilidades para trabajos futuros que continden ampliando el TFG aqui
descrito, como ejemplo de posibles aplicaciones estarian: diagnosticos de salud, labores
de rehabilitacion para pacientes que han sufrido infartos cerebrales, o en el campo de los

sistemas robotizados.
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ANEXO | - INSTALACION Y COLOCACION DEL DISPOSITIVO

(Emotiv EPOC)

Para instalar el kit de desarrollo Emotiv sera necesario ingresar la licencia otorgada
por la compafiia para su posterior registro en linea. Este procedimiento se inicializa
ejecutando el instalador proporcionado. Al tener concluida la instalacion se procederd a

adecuar el dispositivo para su correcto uso.

Antes de comenzar a usar el Emotiv EPOC es necesario cargar el dispositivo
asegurandose que se encuentre apagado, la carga del mismo se lo puede hacer de una toma
de pared o por medio de entrada USB que se encuentra en nuestro computador. Para una
carga total del mismo es necesario tenerlo conectado aproximadamente unas 4 horas. Es
importante saber que no se debe cargar el dispositivo mientras se encuentra colocado en la

cabeza.

Figura 1: Cargar en PC

Figura 2: Cargar desde una
toma de corriente

El dispositivo cuenta con tres leds indicadores colocados en la parte posterior del

casco.
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Azul Encendido
Rojo Cargando la bateria
Verde Carga completa

Tabla 1: Significado leds del EPOC

Antes de usar el dispositivo es necesario verificar si los sensores se encuentran

hidratados con la solucion salina dada en la caja.

Figura 3: Hidratar sensores

Seguidamente al tener los sensores hidratados se procede a colocar cada uno de los
16 sensores proporcionados en la caja en el dispositivo como se muestra en la siguiente

figura.

Figura 4: Colocacion de los sensores

Este proceso también se ha de realizar cuando se termine de usar el dispositivo. Es

necesario retirar uno por uno los sensores y colocarlos nuevamente en su caja.
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A continuacion se insertara el receptor USB en el computador para su posterior

sincronizacién con el mismo y seguidamente se encendera el dispositivo.

Figura 5: Activar el EPOC

La manera de ubicar en la cabeza el Emotiv EPOC headset es la que se observa en
las figura - y -. Con ambas manos, se debe colocar el EPOC desde la parte superior de la
cabeza, descendiendo hasta que se llegue a ubicar los sensores de manera correcta,
recordando que las referencias CMS y DRL deben estar a la altura de las orejas y prestando
atencion en que los sensores de la parte frontal tienen que ser ubicados aproximadamente a

dos o tres dedos desde las cejas hacia el sensor.

Figura 6: Colocacion del Figura 7: Colocacion del EPOC
EPOC
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ANEXO I - Enunciados de préacticas propuestas asociadas al TFG

PRACTICA DE LABORATORIO 1

Aplicaciones practicas y analisis de la adquisicion de sefiales EEG en
tiempo real

1.1.  Objetivos generales

El objetivo de la presente practica es la adquisicion, familiarizacion y estudio de
sefiales de electroencefalografia (EEG) en tiempo real. Para ello, se hara uso de un equipo
de adquisicion dispuesto de sensores para tal fin, el EMOTIV EPOC, y el software
LabVIEW de desarrollo para disefiar sistemas, con un lenguaje de programacion visual

grafico que permite visualizar el comportamiento en tiempo real de las sefiales citadas.

Para la visualizacion de las sefiales EEG, se adjunta un programa en LabVIEW que
cuenta ademas con la opcidn de estudiar la reaccion del sistema nervioso ante acciones

expresivas.

1.2.  Objetivos especificos

Se pretende conseguir la forma de las sefiales EEG producidas como respuesta a

estimulos expresivos concretos, que seran:

- Parpadeo constante
- Sonreir
- Movimiento de cejas

- Fruncir el ceno

Estas sefiales serdn comparadas con casos reales de pacientes que han sido ya
estudiados, con el fin de obtener unos resultados similares. Asimismo, se estudiaran algunas
caracteristicas de las sefiales correspondientes a cada caso, como pueden ser sus amplitudes

maximas y minimas.
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1.3.  Adquisicion de las sefiales EEG

La adquisicion se lleva a cabo utilizando la diadema de la EPOC con sus
correspondientes electrodos, que obtendran sefiales de amplitudes extremadamente
pequefias en un margen de tension de entre 54V y 3004V en un margen de frecuencias de
OHz hasta incluso alrededor de 150 Hz. Para la visualizacion de estas sefiales resulta
necesario la creacion de una interfaz de comunicacion entre la EMOTIV y un programa

disefiado para tal fin. En este caso la plataforma empleada sera LabVIEW.
1.4. Interfaz LabVIEW - EMOTIV EPOC

El software del Emotiv Epoc trabaja con archivos de extension edk.dll y edk_utils.dll,
los cuales son librerias de vinculos dinamicos que contienen una biblioteca de datos y cddigo

que pueden ser utilizados por otros programas al mismo tiempo.

LabVIEW posee unas librerias con las que se puede realizar la interfaz de este con los
archivos ya mencionados y se forma, formandose una dependencia con el programa Control

Panel.

En este Trabajo se ha utilizado una libreria especifica para la EMOTIV que realiza esta

interfaz.
1.5. Libreria EMOTIV TASK para LabVIEW

Para empezar a utilizar la libreria, es necesario tener en cuenta los siguientes vi para

conseguir una correcta interfaz.

15. EmotivCreate Task.vi: en este vi se debe ubicar la direccion del archivo edk.dll y
colocar el path del subvi.

16. EmotivStart Task.vi: se utiliza para iniciar la interfaz.

17. Estructura while: aqui se programa lo que se desea realizar.

18. Emotiv Read.vi: dentro del bucle while, se utilizara para estudiar las acciones
cognitivas deseadas.

19. Emotiv Stop Task.vi: se utiliza fuera del bucle while para establecer la interfaz.

20. Error out: se utiliza para visualizar un error en caso de que se interrumpa la

dependencia.

Pagina 111 de 179



Universidad JORDAN ORTEGA RODRIGUEZ
de La Laguna ALEJANDRO PACHECO CANO

UlLL

El diagrama de bloques tendra la misma estructura para cada accion expresiva que se
desee estudiar y seré el que se muestra a continuacion utilizando las diferentes funciones

incorporadas en la libreria Emotiv Toolkit descritas anteriormente:

B Covedk.dl Emotiv Create Task.wi  Emotiv Start Task.wvi Emnotiv Read.vi Emotiv Stop Task.vi
ruta edk.dll (1) ]:E!w [Ematis ] error out
EmoEngine = -..-

Figura 1: Diagrama de bloques para el estudio de acciones expresivas en LabVIEW

Una vez realizada la interfaz, puede utilizarse el subvi Emotiv Read.vi para estudiar
el comportamiento de las sefiales EEG ante acciones cognitivas o expresivas. Si por ejemplo
se selecciona la opcion Smile, al ejecutar el programa se obtendra un pulso positivo cuando

el dispositivo de electroencefalografia detecte que el sujeto esta sonriendo.

|Srr1i|e 'l
Figura 2: Emotiv Read.vi en LabVIEW

Para que esto pueda ser comprobado visualmente de forma mas sencilla, se colocara
un indicador booleano luminoso (true o false) en el programa que se encendera en el
momento en el que se detecte el pulso positivo. De esta manera, el bucle se presenta del
siguiente modo en cuatro casos correspondientes a cada accion expresiva concreta que

pretende estudiarse:

Péagina 112 de 179



L L Universidad JORDAN ORTEGA RODRIGUEZ
u de La Laguna ALEJANDRO PACHECO CANO
» Parpadeo constante » Sonreir

500

4 000 O 1[0“317 gooouon

Sonreir

100 0000000000000

> Fruncir el cefio

500

10000 2[0..3]'DDDL—

Mover cejas

|

Figura 3: Diagrama de bloques correspondiente a cada accion expresiva en LabVIEW

1.6. Visualizacion de sefiales EEG

Para el correcto estudio de la reaccion del sistema nervioso ante acciones cognitivas o
expresivas, se aporta la visualizacion de las sefiales EEG de los catorce electrodos usados.
Para que esto sea posible, ademas de los vi mencionados anteriormente se hace uso de los

siguientes:

e EEG Data Start.vi: identificador de datos que se utiliza para proporcionar acceso a
los datos de EEG. antes de la recogida de datos, se Inicializa un bufer.
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e EEG Data Acquire.vi: inicia la recuperacion de los Gltimos datos EEG existentes en
el bufer. Ademas, se define el nimero de muestras de datos disponibles, las cuales

se utilizan para crear un bufer de datos de ingreso.

La estructura grafica necesaria para la visualizacion de las citadas sefiales es la siguiente:

J stop
- ®
B hedkdl Emotiv Create Taskwvi 2 _ Emotiv Stop Taskwvi
i oo FFE | [Emetin
FEC

ruta edk.dll (1) [Emsti]

i

EmoEnina - Emotiv Start Task.vi

EEG data -

error out 2

M 5y e data
m PPlot.Name]

7]

Figura 4: Diagrama de bloques de la visualizacion de sefiales EEG en LabVIEW

En este caso, se separan los datos adquiridos en catorce canales diferentes,
correspondientes cada uno de ellos a la sefial captada por cada electrodo respectivo del
dispositivo EMOTIV.

Una vez presentado el entorno grafico de programacion, se pretende profundizar en
el estudio de la variacion de las sefiales EEG ante estimulos cognitivos o expresivos. Es por
ello que en primer lugar se realizara la obtencion practica a tiempo real de dichas sefiales
ante la accidn de artefactos bioldgicos concretos, con el fin de que puedan ser comparadas
con registros originales del mismo tipo de artefacto en cada caso. Para ello, se aportan los

registros de varios usuarios como ejemplo previamente estudiados.
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1.7. Realizacion practica

Para llevar a cabo el estudio, junto al presente guion se aportaran los archivos
necesarios para tal fin. Tras colocarse correctamente la diadema EMOTIV sobre el sujeto
que pretende ser estudiado y verificar el correcto contacto de conexionado entre éste y los

electrodos del aparato, se seguiran los siguientes pasos antes de ejecutar el programa.

1. Abrir el archivo EEG.vi aportado en la presente practica con LabVIEW Instrument.
2. Una vez iniciado LabVIEW, debe seleccionarse la ruta de ubicacion donde se
encuentre el archivo edk.dll en nuestro equipo.

3. Ejecute el programa.

Una vez puesto en marcha el programa, en el panel frontal se visualizara la
representacion grafica de catorce sefiales correspondientes a las proporcionadas
respectivamente por cada uno de los electrodos que incorpora el dispositivo EMOTIV.

EEG data i |
0 aF3 PN
mF
enr N
e Fcs [N
17 %
err N
0o IR
oz [N
DI ]
DRCEN ]
0 Fcs [
e
mr
DECY ]

Amplitude

-200-7 i
36220 37243

Figura 5: Panel frontal de la visualizacién de sefiales EEG en LabVIEW

Ademas, se afiaden indicadores booleanos luminosos para cada accion expresiva, los
cuales se iluminaran en cada caso cuando el blogque funcional de cada accidn (parpadeo,

sonreir, mover cejas y fruncir el cefio) proporcione un pulso activo en su salida. Por
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ejemplo, cuando el sujeto sonria se encendera el indicador luminoso correspondiente y asi

de la misma forma para los tres casos restantes.

Gracias a estos indicadores, se facilita la tarea de estudiar las sefales EEG

correspondientes al tipo de accion expresiva que pretende estudiarse en cada caso.
1.8. Resultados

Las sefiales obtenidas deberan ser similares a las que se muestran a continuacion, las cuales

corresponden a sujetos previamente estudiados.

» Parpadeo

EEG data HEE |
V=N ] -
oF
o g
e0Fcs PN
ED_T7
ED_P7
£D_01
ED_02
ED_P2
ED_T8

-300) Il
12688 1371
Samples

Parpadeo Sonriendo

Figura 6: EEG del parpadeo constante

> Sonreir

EEG data +HEw
[N ]
ED_F7
EDF3
0 rcs RN
ED_T7
ED_PT
ED_O1
ED_02
ED_PE
ED_T&

,,,,,,,

ED_F4

-200 d
20748 2
Semples

Movimiento Fruncir el
de cejas cefio

O @ o

Sonriendo

Figura 7: EEG durante la sonrisa
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» Movimiento de cejas

EEG data |
error out 2
‘status  cede

1 4 0

| source

mmm
888
et
33

ED_FC5
ED_T7
ED_P7
ED_O1
ED_02
ED_P8
ED_T8
ED_FC6

800~
600-]

Amplitude
<

13167,

5808
raE
EEN
58 &
E

el S

] Movimiento Fruncir el
Sonriendo AhT- i,

» o 9

Figura 8: EEG ante un movimiento de cejas constante

> Fruncir el cefio

EEG data Bevo
error out 2
status  code

7 0

| source

555
a3 =
b

ED_FC5
ED_T7
ED_PT
ED_O1
ED_02
ED_P8
ED_TE
ED_FC6

Amplitude

s1o8 Samples

5885
3=
RER

. Movimiento Fruncir el
Sonriendo de cejas edfib.

® o J

Figura 9: EEG ante la accion de fruncir el cefio
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PRACTICA DE LABORATORIO 2

Adquisicién y familiarizacion de las sefiales EEG mediante la utilizacion

de una herramienta comercial de proceso (EEGLAB)

1.1. Introduccién

Esta practica esta disefiada para que el estudiante se familiarice con el entorno EEG
mediante una aplicacion del programa MATLAB. Se podrad estudiar cualquier sefial

guardada de un aparato de electroencefalografia, en este caso del Emotiv Epoc.

1.2.  Objetivos

1. Adquirir la sefial EEG
2. Familiarizarse con la aplicacion EEGLAB
3. Realizar una serie de ejercicios relacionados con la aplicacion

1.3. Marco teorico

El electroencefalograma, encefalograma o EEG es una prueba que se usa para
estudiar el funcionamiento del sistema nervioso central, concretamente de la actividad de la
corteza del cerebro. La actividad coordinada de miles de neuronas produce diferencias de
potencial en el cuero cabelludo que pueden ser registradas utilizando electrodos en
conjuncién con amplificadores de sefial. Es decir, colocando una serie de electrodos
repartidos por la cabeza podemos hacernos una idea de en qué zonas de nuestro cerebro se

esta produciendo mayor actividad.

Para estudiar las sefiales EEG se utilizara la herramienta interactiva para MATLAB
Ilamada EEGLAB. Esta herramienta esta disefiada para el procesamiento de EEG, MEG y

otros datos electrofisioldgicos que incorporen el ICA (Independent Component Analisys),
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analisis de tiempo/frecuencia, estadisticas relacionados con el evento y varios modos de
visualizacion del promedio y los datos de una sola prueba. Fue desarrollada en MATLAB
5.3 bajo Linux. Actualmente se puede ejecutar en MATLAB V5 y superiores bajo Linux,
Unix, Windows y Mac OS X. Se puede descargar de manera gratuita en su péagina oficial.

1.4. Materiales

e Equipo Emotiv Epoc
e PC instalado Matlab
e Libreria EEGLAB

1.5.  Procedimiento
La adquisicién de la sefial de EEG se realiza por medio del Emotiv Epoc. En este

caso la adquisicion ya se ha realizado mediante el TESTBENCH y se ha guardado un archivo

.edf de aproximadamente dos minutos de duracion.

BRREE Rintonlass

Figura 1: Emotiv EPOC
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Para un buen uso del EEGLAB es fundamental una correcta instalacion. Se
descomprime el archivo y se instala en la carpeta toolbox de Matlab (C:\Archivos de
programa (x86)\MATLAB\R2012b\toolbox). Para poder trabajar con la toolbox solo es

necesario ejecutar eeglab en MATLAB.

@) New to MATLAB? Watch this Video, see Demos, or read Getting Started. X

eeglab: options file is C:\Users\Pacheco\eeg_options.m

EEGLAB: adding "Biosig" to the path; subfolders (if any) might be missing from the path

EEGLAB: adding "dipfit" v2.3 (see >> help eegplugin dipfit)

EEGLAB: adding "firfilt" v1.6.1 (see >> help eegplugin firfilit)

Could not check for the latest EEGLAB version (internet may be disconnected).

To Frevent long startup time, disable checking for new EEGLAB version (FIle > Memory and other o
fx >>

Figura 2: Ejecutando EEGLAB

o EEGLAB v1343b - o

|| File Edit Tools Plot Study Datasets Help N

i __No current dataset

- Create a new or load an existing dataset:
Use "File > Import data” {new)
Or "File > Load existing dataset” (old)

- If new,
"File > Import epoch info" (data epochs)
“File > Import event info" (continuous data)
"Edit > Dataset info” (add/edit dataset info)
"File > Save dataset” (save dataset)

- Prune data: "Edit > Select data”

- Reject data: "Tools > Reject continuous

- Epoch data: "Tools > Extract epochs”

-R baseline: "Tools > R

-RunICA: "Tools > Run ICA"

Figura 3: Ventana EEGLAB

Para leer la sefial se tendran que seguir los siguientes pasos:

e El archivo se llamara “pruebal.edf” y estara localizada en la carpeta
correspondiente

e Como se trata de una sefial capturada con un Emotiv Epoc se insertard
mediante: File-> Import data -> Using EEGLAB functions and plugins ->
From EDF/EDF+/GDF files (BIOSIG toolbox)

e Seguidamente saldrd una ventana donde debemos poner los canales que
deseamos ver (Channel list). En principio se pondran desde el 3 hasta el 16
(los 14 electrodos que posee el Emotiv Epoc). Importante: Hay que poner

todos los numeros desde el 3 hasta el 16, el formato 3-16 no es valido.
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Ademas se deberan importar las posiciones de los electrodos. Para ello se incluira

un archivo .ced donde estén las coordenadas de cada electrodo. Este archivo se puede

visualizar con el bloc de notas por si requiere alguna modificacion.

e Se pueden importar estas posiciones utilizando: Edit -> Channel Locations -
> Read Locations
e Seleccionar el archivo “canales official.ced”. Una vez cargadas las
posiciones se deberia visualizar como en la llustracion 4
e Paravisualizar la posicién de los electrodos (llustracion 5): Plot -> Channel
Locations -> By Name/By Number
n Edit channel info -- pop. chanedit() - oIl n Figure 2 - =IEN
Channel information (“field_name"): File Edit | View Inset Tools Desktop Window Help ~
Channel label ("label") AF3 Opt head center | NEdS M KAODERL- G 0B D
Polar angle ("theta”) -22.461 Rotale axis
Polar radius (‘radius”) 042113  Transformaxes | Channel locations
Cartesian X ("X") 76.1528
Cartesian Y ("Y") 314828 Xyz -> polar & sph.
Cartesian Z ("2") 20,8468
Spherical honz angle ("sph_theta") 22 461
Spherical azimuth angle ("sph_phi”) 14197
Spherical radius ("sph_radius") 85 ___ Setheadradius |
Channel type Set channel types |
Reference ____Setreference
Index in backup 'urchanlocs’ structure 1
Channel in data aray (set=yes)
JE‘?EL"L‘ Channel number (of 14)
insertchan | | << P 1 > > Append chan
Plot2.0 | Plotradius (02-1, [auto) Nosealong+X  v| _Plot3D (xy2) |
Readlocations | Readlocshelp | Lookuplocs | Save(as.ced) | Save (othertypes)|
_ Hep | _cancel || ok | 14 of 14 electrode locations shown
Figura 4: Channel Locations Figura 5: Posicion de los electrodos

Una vez configurada la localizacién de los electrodos ya se puede visualizar y

segmentar la sefial EEG. Para poder ver la sefal:

Plot -> Channel Data (Scroll)

Utilizar los signos +/- para cambiar la escala de la sefial y las flechas para
navegar a lo largo de ella. No es necesario visualizar los 14 electrodos para
poder segmentar la sefial pero si deseamos verla como en la imagen

predeterminada no aparecen hay dos formas de solucionarlo:

a) Cambiando la escala hasta poder verlas todas. Esto tiene un

problema ya que no se aprecian los cambios de las sefiales.

Pagina 121 de 179



Universidad JORDAN ORTEGA RODRIGUEZ
de La Laguna ALEJANDRO PACHECO CANO
AFAO 1 — —Az ”: I "Jw— B rﬁ I

[eaees )| | o BB s oomwm v v | REJECT |

Figura 6: Visualizacion electrodos 1

b) Podemos visualizar los canales de 7 en 7 o en el rango que se desee en:

Settings -> Number of channels to display

Ll

I L/ NI ANN NN VWS

Time

o mzn ue | B seect

Figura 7: Visualizacion electrodos 2

e Para guardar una parte de la sefial: Edit -> Select Data-> Time Range

e Para visualizar los diferentes datasets s6lo hay que seleccionar la ventana

“Datasets”

Si se desea eliminar las tendencias ascendentes o descendentes se puede eliminar la
linea base de las sefiales (offset) mediante Tools -> Remove baseline.

Para poder representar los espectros de la potencia es recomendable realizar un
analisis de componentes independientes (ICA). Se ejecuta de la siguiente manera: Tools->

Run ICA. Finalmente para representar los espectros habra que ir a: Plot -> Channel spectra
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and maps. Es recomendable poner en las frecuencias a representar los valores medios de las
bandas alfa, beta, delta y theta (2, 6, 10, 21).

1.6. Ejercicios propuestos

Debido a que esta practica consiste en la familiarizacion de la sefial EEG con la
aplicacion EEGLAB no existen resultados de esta. Por lo tanto se han elaborado varios
ejercicios para comprobar si el alumno ha entendido correctamente el procedimiento. Hay
que recordar que el archivo .edf se ha creado con dos intervalos bastante diferenciados de

cara a algunos de estos ejercicios.

Pregunta 1: Una vez que cargamos el archivo y seleccionamos los canales que

gueremos ver ¢qué datos mas relevantes nos da el programa?

)] EEGLAB v1343b - oiEM

File Edit Tools Plot St Datasets  Help ~
__#1: EDF file

Filename: none

Channels per frame 14

Frames per epoch 15488

Epochs 1

Events none

Sampling rate (Hz) 128

Epoch start (sec) 0.000

Epoch end (sec) 120.992

Reference unknown

Channel locations No (labels only)

ICA weights No

Dataset size (Mb) 1

Figura 8: Ventana EEGLAB

Respuesta:

NUmero de canales: 14

Fotogramas por tiempo: 15488

Tiempo Inicial y tiempo final: 0-120.992 seg
Frecuencia: 128 Hz

Tamaiio del archivo: 1 Mb
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Pregunta 2: Visualizar las posiciones de los electrodos del Emotiv Epoc y decir

en cuéntas zonas cerebrales se sitian dichos electrodos segiin su nombre y posicion.

Respuesta: Cada hemisferio posee varias cisuras que lo subdividen en I6bulos: El

I6bulo frontal, El 16bulo parietal, El I6bulo occipital, El 16bulo temporal.

) e ()
L0000

) ) ) 65 ) ) €)1

Figura 9: Sistema 10/20 EEG Figura 10: Electrodos Emotiv Epoc

A continuacién, se exponen y describen las denominaciones estandar de los
electrodos. (Nota: por convencion, los electrodos designados con ndmeros impares se

localizan a la izquierda, y los pares a la derecha).

e F3/F4= Mediofrontal sobre el I6bulo frontal (registra la actividad frontal)

e FC5/FC6 = Frontal central

e F7/F8= Frontal inferior, en ocasiones denominado temporal anterior (registra
la actividad de las regiones orbitofrontal, frontal lateral y temporal anterior).

e T7/T8= Temporal medial (registra la actividad de las regiones temporales
anterior y medial).

e P7/P8 = Parietal (registra la actividad parietal).

e 01/02= Occipital (registra la actividad occipital).
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Pregunta 3: Al visualizar la sefial completa ¢Por qué crees que se produce un
cambio en la sefial? ¢ Qué diferencia ves? Genera dos datasheets que contengan las dos
partes diferenciadas. Indica que intervalos de tiempo has escogido.

Respuesta: Se ve claramente dos partes diferenciadas. En primer lugar las sefiales
varian mucho presentando altos niveles de irregularidad hasta el segundo 40-45 donde se
estabilizan la mayoria. Esto es debido a que en los primeros segundos de la prueba el sujeto
se ha estado moviendo y realizando acciones faciales mientras que pasado el segundo 45 ha
presentado un estado de reposo en el cual solo se pueden ver como variacion de la sefial a
los parpadeos.

Figura 11: Parte 1 (0-45 segundos)

Figura 12: Parte 2 (45-120 segundos)
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Pregunta 4: ¢ Que ventaja ves que aparece al eliminar la linea de base?

Respuesta: Aparte de lo mencionado anteriormente de eliminar las tendencias
ascendentes o descendentes también se puede ver como ahora vemos las 14 sefales en el

plot con la misma escala.

Figura 13: Sefial sin linea de base

Pregunta 5: Genera dos segmentos de 5 segundos de cada uno de los dos datasets
creados anteriormente que se encuentren lo menos contaminado por ningun artefacto,
es decir, que no tengan demasiado ruido. Indica los instantes de tiempo de estos dos
segmentos y haz captura de pantalla de ellos. Calcula su espectro antes y después de

eliminar la linea de base. Comenta las diferencias.

Respuesta: Aqui tenemos el ejemplo de un segmento escogido del segundo dataset,
en concreto del segundo 47 al 52. En las imagenes de la izquierda se muestran con la linea

de base mientras que en las figuras de la derecha se muestran sin ésta.
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Figura 14: Con linea de base Figura 15: Sin linea de base

En las figuras que contienen la linea de base, la potencia es mucho mayor que a las
que se les suprimio ya que la linea de base representa un valor promedio en cada una de las

sefiales.

Power 10%10g, (1 /Hz)

Power 1009, (/' Mz)

Figura 16: Potencia con linea de base Figura 17: Potencia sin linea de base

Pregunta 6: ¢Qué es lo que hace el programa cuando representas las sefiales,
seleccionas una parte y presionas reject? Realiza una captura de pantalla del antes y el

después. ; COmo mejorarias esa funcion?

Respuesta: Al presionar reject se elimina la parte seleccionada. Una manera de
mejorar esta funcion seria que en lugar de eliminar todos los electrodos de la parte

seleccionada se podria reemplazar los electrodos con ruido por una linea horizontal.
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Figura 18: Parte seleccionada Figura 19: Sefial con la parte eliminada

Pregunta 7: Utiliza el resto de funciones disponibles en el EEGLAB y comenta
su funcionalidad (cambio de referencia, cambio de la frecuencia de muestreo, reject

continuous data by eye)

Respuesta:

Change sampling rate

Filter the data

Re-reference
Interpolate electrodes
Fram|| Reject continuous data by eye
X Extract epochs
Remove baseline

Reject continuous data by eye
Extract epochs
Remove baseline

Figura 19: Change sampling rate Figura 20: Reject continuous data by eye

Figura 21: Change sampling rate
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o Re-reference: Esta funcion permite tomar otro canal de referencia y darle valores.

e Change sampling rate: Es la velocidad de muestreo, asi que si originalmente tiene
dado 1000/s y se lo cambio a 10 (demostrativo) la calidad sera menor.

e Reject continuous data by eye: Se pueden quitar partes de la sefial que no son de

interés.
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PRACTICA DE LABORATORIO 3

Visualizacion en tiempo real de los potenciales del cerebro

1.1. Introduccién

Ademas de poder utilizar las sefiales del cerebro para visualizar las ondas también
podemos visualizar la potencia que nos dan los electrodos en una visualizacion con colores
que nos indican que parte del cerebro esta generando un mayor potencial en una determinada

actividad.

1.2. Objetivos

1. Conseguir un mapeo en 2D y en 3D del cerebro utilizando el programa OpenViBE

1.3. Marco teérico

OpenViBE es una plataforma de software dedicada a disefiar, probar y usar interfaces
cerebro-computadora. El paquete incluye una herramienta de disefio para crear y ejecutar

aplicaciones personalizadas.

OpenViBE es un software que permite el procesamiento en tiempo real de las sefiales
cerebrales. Puede utilizarse para adquirir, filtrar, procesar, clasificar y visualizar las sefiales
del cerebro en tiempo real. Los principales campos de aplicacion de este programa son
médicos (asistencia a personas con discapacidad, biorretroalimentacion en tiempo real,
neurofeedback), multimedia (realidad virtual, videojuegos), robética y otros campos de

aplicacion relacionado con interfaces cerebro-computadora.

En la pagina oficial se encuentra disponible el software para descargarlo directamente

de forma gratuita.
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1.4. Materiales:

e Emotiv Epoc
e PC instalado OpenViBE

1.5. Procedimiento

La adquisicion de la sefial de EEG se realiza por medio del Emotiv Epoc. Para un
buen funcionamiento los electrodos deben estar humedecidos y en el CONTROL PANEL se

debe comprobar la correcta ubicacion de estos.

Emotiv Control Panel 2.0.0.20-PREMIUM

R Retioe

Figura 1: Emotiv Epoc Figura 2: Control Panel

Una vez verificada la sefial de los electrodos podemos cerrar la aplicacion de
CONTROL PANEL vy abrir el programa OpenViBE Designer.

Se programa la aplicacion para que realice lo siguiente:

e Mostrar las sefiales de todos los electrodos

e Mostrar el espectro de cada ritmo

e Visualizar en 2D y 3D la situacién real de los electrodos en la cabeza

e La localizacion de los electrodos es la que viene en las librerias
(Openvibe/share/electrode_sets)

e El filtro creado (Temporal filter) es un Butterworth de orden 4 pasa banda

con una frecuencia de corte distinta para cada ritmo (alpha, beta, theta y delta)

Pagina 131 de 179



Universidad JORDAN ORTEGA RODRIGUEZ
de La Laguna ALEJANDRO PACHECO CANO

e Se ha afadido un selector de bandas de frecuencia para que el espectro solo

muestre los valores entre el rango de frecuencia dado.

Los cuatros casos tienen la misma estructura. Solo se debera cambiar el rango de

frecuencia.

Signal display
Sefial Electrodos

In|Out|Set

Temporal fiter
Filtro Butherworth Pa\g]abanda 1-4 HZ (Delta)

oy
Time based epoching
InjOut|Set
S

7
Spectral analysis (FFT)
YT
“F
Frequency nd Selector
S

Power spectrum display

DELTA

oy
Simple DSP
InjOut|Set
=7
57
Signal average
“F

7
Epoch average
InjOut|Set
y:

2D topographic map

DELTA 2D

(Electrode local'swation file reader] (Electrode localtion file reader]

3D topographic map

DELTA 3D

Figura 3: Parte del programa que representa Delta

A continuacion se deberd abrir la aplicacion OpenViBE Acquisition Server
para hacer la interfaz con el programa y el Emotiv Epoc. Lo primero que hay que configurar

es la ruta de la libreria del Epoc (.dll) y seguidamente establecer la tasa de muestreo a 128.
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Figura 4: Driver configuration

Una vez conectado solo se necesita activar el disefio presionando el botén “play” del

OpenViBE-designer.

Figura 5: Adquisition Server
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1.6. Resultados

Una vez realizado todo el procedimiento se deberia ver algo parecido a la siguiente figura.

® DELTA = =l & THETA = = L] ALPHA s =l ® BETA e il
@ DELTA | Q THETA ] @Q ALPHA | aQ BETA
~J1: “11:AF3 1:AF3 1:AF3
el L P e
2:F7 “ 2:F7 ‘ 2:F7 III 2:F7
3:F3 = 3:F3 a 3:F3 3:F3
G:FCSJ- 4:FCS 4:FCS 4:FCS g -
£ i ) i T I ‘
5:77 La 5:77 Sl 5:77 I. 5:77
Lls:w #5F7| g | 6:P7 | | 6:P7 o
0 369 12 16 20 24 28 32 36 0 3 6 9 12 16 20 24 28 32 3 0 369 12 16 20 24 28 32 3% 0 3 6 9 12 15 18 21 24 27 30 33 36
® DELTA 2D SlE ® THETA 2D = ® ALPHA 2D =a ® BETA 2D = =

L DELTA 20 | THETA 20 | Ol ALPHA 2D |

= +
® petazp - o HEMe THETA3D - O
(o} DELTA 0 £ THETA O

Figura 6: Mapeo de los ritmos en 2D y 3D

Tanto la figura 3D como la 2D se puede rotar y ajustar a las preferencias del usuario.
No se ha mostrado la gréafica de los 14 electrodos pero al estar programada también aparecera

en las graficas finales.

1.7. Conclusiones

Al revisar las graficas podemos observar las partes que trabajan en el cerebro al hacer
diferentes actividades, ademas con el espectro podemos ver las frecuencias en los intervalos

de cada ritmo.
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PRACTICA DELABORATORIO 4

Elaboracién de un interfaz de comunicacién entre el Emotiv EPOC y

Arduino.

1.1. Introduccién

El uso de las sefiales del cerebro es muy utilizado ya que con estas y con una correcta
interfaz se pueden lograr mover objetos, accionar dispositivos o indicar el grado de un estado

del cerebro como por ejemplo se hara con esta préctica.

1.2. Objetivos

1. Conseguir encender un led cuando una persona sonria

2. Indicar el grado de meditacion en el que estd una persona mediante una serie de

leds

1.3. Marco tedrico

Para poder conectar el Emotiv Epoc con el Arduino se necesita un procesador que
recoja las sefiales del aparato y envie los comandos a la placa. El procesador utilizado se
llama “Processing” y es en €l donde se realizara el codigo de programacion. Para esta

practica se necesitaran tres programas:
Mind your OSCs — Processing — Arduino

Mind your OSCs: Esta aplicacion permite enviar datos de EPOC como paquetes OSC
(Open Sound Control) a otros programas. Se puede descargar de manera gratuita en la pagina

oficial de Emotiv.

Pagina 135 de 179



Universidad JORDAN ORTEGA RODRIGUEZ
de La Laguna ALEJANDRO PACHECO CANO

Processing: Es un lenguaje de programacién y entorno de desarrollo integrado de
cddigo abierto basado en Java, de facil utilizacion, y que sirve como medio para la ensefianza
y produccion de proyectos multimedia e interactivos de disefio digital. Es gratuito y se puede

descargar en la pagina oficial.

Arduino: Es una plataforma de hardware libre, basada en una placa con un
microcontrolador y un entorno de desarrollo, disefiada para facilitar el uso de la electronica
en proyectos multidisciplinares. EI microcontrolador se programa mediante el lenguaje de
programacion Arduino (basado en Wiring) y el entorno de desarrollo Arduino (basado en
Processing).

1.4. Materiales:

Emotiv Epoc

e PC instalado Mind Your OSCs y Processing

e Arduino (hardware y software)

e Protoboard

e 6 leds (rojo, naranja, amarillo, verde, azul, violeta)
e 6 resistencias de 330 Ohmnios

e Cables

1.5. Procedimiento

Primero se realizaran los circuitos eléctricos, los cuales son bastantes sencillos. En el

primer caso solo se ha de conectar el led directamente al Arduino (si es de alta impedancia)

Figura 2: Caso 2

Figura 1: Caso 1
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ULL

mientras que en el segundo caso se le han puesto a cada led una resistencia para evitar una

sobrecarga.

La adquisicion de la sefial de EEG se realiza por medio del Emotiv Epoc. Para un
buen funcionamiento los electrodos deben estar humedecidos y en el CONTROL PANEL se

debe comprobar la correcta ubicacion de estos.

Emotiv Control Panel 20.0.20-PREMIUM

Figura 3: Emotiv Epoc Figura 4: Control Panel

Una vez verificada la conexion de los electrodos abriremos la aplicacién Mind Your

OSCs y conectaremos el programa al Control Panel y a OSC.

Emotiv | 0sC

Control Panel fi
ILZT.J,I_,_ IZZ—' s
l?x‘n‘« I74{:“
Disconnect l Connect :
Disconnect l Connect
Figura 4: Conexion del Figura 5: Activacion para
EPOC al programa enviar paquetes OSC

Ahora se abrira Processing para llevar a cabo la programacion. Se programa la

aplicacion para que realice lo siguiente:
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e (Caso 1: Un led debe encenderse mientras el sujeto este sonriendo

e Caso 2: Unaserie de leds deben mostrar al usuario el nivel de meditacion que

posee en cada momento

En dicho programa se invoca a las librerias de Arduino y de Mind Your Oscs. Es

muy probable que estas se tengan que descargar. Ambas son gratuitas:

e 0scP5 (http://www.sojamo.de/libraries/oscP5/)

e Arduino (http://playground.arduino.cc/Interfacing/Processing)

A continuacion se pueden ver los codigos de los distintos casos:

Programa 1:

import processing.serial.+*;
import cc.arduino.+*;
import oscPS.+*;

Arduino arduino; // dec
OscPS oscPS;

Epoc

float smile = 0; // Valor de entrada del
int LED = 13;// EL pin 13 del Arduino es al que debe conectarse el led

void setup() {
println{Arduino.list()); // busca Arduines dis
'/ comienza la comunicacion con el Arduinc a S

arduino = new Arduino(this, "COM5", 57600);

/ establecemos el led como un pin de salida
arduino.pinMode(LED, arduino.OUTPUT);

'/ comienza oscP5, recibe los mensajes del puerto 7400 (este valor

se debe comprobar ya que puede cambiar)
oscP5 = new OscPS5(this, 7400);
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}

f* aqui se reenvian automaticamente los mensajes de 0SC

que tienen como patron la direccion fEXP/SMILE to getSmile()

el cual actualiza la variable Smile con el valor del mensaje de 0SC */

oscP5.plug(this, "getSmile", "/EXP/SMILE");

void draw() {
f* Si el valor que recibe de smile(sonrisa) e

led debera encenderse. En caso contrario est

}

}

}
}

N
de

s

println("0SC message received; new smile value:

f (smile
arduino.
else {
arduino.

digitalWrite(LED, arduino.HIGH);

digitalWrite(LED, arduino.LOW);

S
e

esta funcion actualiza Smile con el valor del
/EXP/SMILE, establecido en el setup () =*/

void getSmile (flcat thevValue) {

mile = theValue;

Programa 2:

igual a 1, valor maximo, el
permanecera apagado */

mensaje 0SC

"+smile);

1/ Trabafé

' Jordan

/ Caso 2:

import pro
import cc.
import osc

Fin de Grado
Ortega y Alejandro Pacheco
Meditacidn

cessing.serial.*;
arduino.*;
PS.*;

Arduino arduino;
OscP5 oscP5;

public float med = 0;

/ Ahora d

int ROJO =
int NARANIJ
int AMARIL
int VERDE
int AZUL =
int VIOLETA = 8;

void setup

println(

arduino

eclaramos para cada pin un led
13;

A= 12;

LO = 11;

= 10;

9;

01
Arduino.list());

= new Arduino(this, "COM5", 57600);

Pagina 139 de 179



Universidad JORDAN ORTEGA RODRIGUEZ
de La Laguna ALEJANDRO PACHECO CANO

arduino.pinMode(R0JO, arduino.QUTPUT);
arduino.pinMode (NARANJA, arduino.OUTPUT);
arduino.pinMode (AMARILLO, arduino.QUTPUT);
arduino.pinMode (VERDE, arduino.QUTPUT);
arduino.pinMode(AZUL, arduino.OUTPUT);
arduino.pinMode(VIOLETA, arduino.OUTPUT);

oscP5 = new OscP5(this, 7400);

oscP5.plug(this,"updateMed"," /AFF/Meditation");

1
void draw() {

if(med>= 0.15) {

arduino.digitalWrite(VIOLETA, arduino.HIGH);
b
if(med>=0.36){

arduino.digitalwWrite(AZUL, arduino.HIGH);

1
if(med>=0.41){

arduino.digitalWrite(VERDE, arduino.HIGH);
1

if(med>=0.47){

arduino.digitalWrite(AMARILLO, arduino.HIGH);
1

if{med>=0.55){

arduino.digitalWrite(NARANIA, arduino.HIGH);
1

if{med>=0.66){

arduino.digitalWrite(R0JO, arduino.HIGH);

-

else {
arduino.digitalWrite(VIOLETA, arduino.LOW);
arduino.digitalWrite(AZUL, arduino.LOW);
arduino.digitalWrite(VERDE, arduino.LOW);
arduino.digitalWrite(AMARILLO, arduino.LOW);
arduino.digitalWrite(NARANIJA, arduino.LOW);
arduino.digitalWrite(R0J0O, arduino.LOW);
1
1
public void updateMed (float theValue) {
med = theValue;
println("0SC message received: new med value: "+med);

}

Una vez realizado el cédigo se debe cargar la libreria Standard Firmdata de Arduino.
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Configurar Pagina Ctrl+Mayis+P ArduinolSP
Imprimir Ctrl+P
Bridge L4
Preferencias Ctrl+Coma EEPROM »
Salir Crl+Q Esplora '
Ethernet [
Firmata ) AlllnputsFirmata
G5M ) AnalogFirmata
LiquidCrystal ) EchaoString
Robot Control ) OldStandardFirmata
sD ) ServoFirmata
Servo [ SimpleAnalogFirmata
SoftwareSerial ) SimpleDigitalFirmata
SPI ) StandardFirmata
TFT r

Figura 6: Standard Firmdata

Ahora solo queda ejecutar los programas en Processing y comprobar el resultado.

1.8. RESULTADOS:

Una vez realizado todo el procedimiento se deberia ver algo parecido a las siguientes

figuras.
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Programa 1:

Figura 7: Comparativa entre la accion expresiva de un sujeto y su respuesta en el circuito
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Programa 2:

| L P L L L L L |

] 5 10 15 AN 5 0

L L L L L L |

0 5 10 15 2 5 £l

Figura 8: Ejecucion del programa de meditacion

1.9. CONCLUSIONES:
Este aparato tiene mucho potencial ya que es facil de manejar y posee una infinidad

de aplicaciones para desarrollar. Grandes proyectos como controlar un coche o una silla de

ruedas con la mente se pueden desarrollar sin duda con el Emotiv EPOC.
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Path del edk.dll

ANEXO 11l - Diagrama de bloques para la adquisicién de
sefiales EEG en LabVIEW a través de Emotiv EPOC

Emotiv Create Task.vi

Emotiv Start Task.vi

EEG TESTBENCH

B Muestras
e B—#e

Canal Individual

»351]|Delta

3 po6i]|Theta

3051 Alpha

<E) —@Ism

stop

E=-

Emotiv Stop Taskyi

<— dosi] |EEG data

Lﬁﬂeumm EEG en CSV

EmoEngine 7|

W[True ~P]
i} [[] EEGdata
[ ——)
[z
Plot.Name
I
Marker
= (True ~Pla=ooo)
o L
a
" e
|
!
L
»Astop 2 alse v | Emotiv Stop Task.vi
E.. = X
0>0m - e
W+
3> stop 2
lectue  [ZE3-@)

Height |

Ubicacién del archivo CSV/

# elements

Width | 1
Numitems ) o)
RingText |
String=l] Y
i

Pat
= ki

[ replace or create |
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ANEXO 1V -Blogues funcionales utilizados para la adquisicion de
sefiales EEG en LabVIEW

A continuacidn, se presentan con detalle algunas de las funciones de LabVIEW utilizadas
para la elaboracion del diagrama de bloques correspondiente a cada apartado de los que se

compone el programa que se ha explicado en la Memoria del presente documento.

e Flatten To String: convierte cualquier entrada en un string de desplegado de datos

binarios.

anything == (5] data skring
prepend array or skring siz... J—@‘D{ L bype skring (7.0 only)
bevte order (0:big-endian, n... E P e prror ouk

&rror in {no error)

Figura 1: Funcion Flatten to String de LabVIEW

e Index Array: devuelve un subarray o elementos de una matriz de n dimensiones al
indice. En su entrada index se colocara un controlador numérico para la eleccion del
canal de la sefial EEG cuyo espectro se desee visualizar. En su entada de array se
conectara el array de dos dimensiones (2D) correspondiente a la salida del EEG

Data.vi.

n-dimenzion array

index 0 ——=* |
index p-1 B0

element or subarray

Figura 2: Funcién Index Array

e Bucle For Loop: ejecuta un subdiagrama un ndmero determinados de veces
predeterminado.

|

Figura 3: Funcién For Loop de LabVIEW
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e Butterworth Filter.vi: filtro de frecuencia seleccionado de tipo Pasa Altas de orden

3, y una frecuencia de corte de 0,1 Hz con el fin de eliminar valores de offset.

filter type — ]
X B Filtered X

Error

F

sampling freq: fs
high cutoff freq: fh
low cutoff freg: fl
order ———

init/cont (inigF) e

Figura 4: Funcién de filtro Butterworth Paso
Alto de LabVIEW

e Collector Express: recoge las sefiales de entrada y devuelve los datos mas recientes,

hasta el nimero maximo especificado de muestras por canal.

Collector
Signals pm— .
Enable = ? e | lected Signals
ﬂ""'?“ error out

errer in (ne error) = :
e H

Figura 5: Funcion Collector Express de LabVIEW

e Spectral Measurements: realiza la transformada FFT de las sefiales EEG para su
representacion en el dominio de frecuencias, gracias a ello podra visualizarse la

magnitud del espectro de cada una de ellas.

Spectral Measurements

Signals s
error in (no errar) =

] EF‘ e Pigyyer Spectrum

Figura 6: Funcién Spectral Measurements de
LabVIEW
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o Filter Express: filtros de frecuencia de tipo Pasa Banda de topologia Butterworth de

orden 3, disefiados con el fin de separar las sefiales en diferentes rangos de frecuencia

correspondientes a cada uno de los ritmos o potenciales mencionado anteriormente.

Figura 7: Filtros Pasa Banda para cada ritmo en LabVIEW

e Array Max & Min: devuelve el valor maximo y el minimo de un array de datos, lo

cual resulta Util para la representacion gréafica de bandas de ritmo como indicadores

visuales, representando los picos o valores maximos de la magnitud del espectro de

cada sefial EEG durante el tiempo en el que se ejecucién del programa.

Array Maoc 8 Min

max value
max index(es)
min value
min indexies)

array

Figura 8: Funcion Array Max&Min
en LabVIEW

e Obtain Queue: devuelve la referencia hacia una cola de datos.

max queue size (-1, unlimited)

name (unnarmed) N P guele ok
element data type of | I created new?
create if not Found? {T) m.ﬂ B grror ouk

errar in (no errar)

Figura 9: Funcién Obtain Queue en LabVIEW

Pagina 147 de 179



Universidad
de La Laguna

ULL]

JORDAN ORTEGA RODRIGUEZ
ALEJANDRO PACHECO CANO

Enqueue Element: afiade elementos al final de una cola de datos.

queye = o R QUelE ouk
Element "'E_I_D_}m] ................... t"TIEd Dut?
kimeouk in ms (-1) E=apror ouk

.

EFFOr in {no error)

Figura 10: Funcion Enqueue Element en LabVIEW

Release Queue: devuelve la referencia hacia una cola de datos.

X

quUEUs Name

Farce destrow? (F) -ITk

remaining elements

errar in (no error) =

Bem e ok

Figura 11: Funcién Release Queue en LabVIEW

e Array to spreadsheet string: esta funcion se encarga de convertor un array de

cualquier dimension a una tabla de en forma de string con el fin de separar elementos

de alguna fila o columna.

deliriter [T ah)
format string

B

array

spreadsheet string

Figura 12: Funcion Array to Spreadsheet String de LabVIEW

existente.

prompk

Open/Create/Replace File: se encarga de abrir, crear o remplazar un archivo

File path {use dialog)
operation (0:open)

refrurm ouk

cancelled

access (0ireadfwrite) -
errar in I

disable buffering (F)

B @rror ouk

Figura 13: Funcion Open/Create/Replace File de LabVIEW
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e Write To Text File: se encarga de escribir un string o un array de strings como lineas
en un nuevo archivo.

prompt {Choose ar enter fil. .,

file (use dialog) refrium ok
text - % cancelled

Error in == &= error qut

Figura 14: Funcion Write To Text File de LabVIEW

e Get Queue Status: devuelve informacién sobre el estado actual de una cola, como

puede ser el nimero de elementos actualmente en la cola.

max qUeLe size
qUEUE Name
queue m—atmm queue ouk
return elements? (F) - 1T —|_'— # pending remove

EFrar in (no error) == Lﬂ# pending inserk
errar aut

# elements in queue

elements

Figura 15: Funcién Get Queue Status en LabVIEW

e Dequeue Element: elimina un elemento que se encuentre al principio de una cola y
devuelve el elemento. Si la cola esté vacia, la funcién espera un determinado tiempo

definido en milisegundos.

qUEUE fo E.... T |:|L|EL|E |:l|_|t
kirmeout in ms (-1) M0 b glement
Error in (no error) = L timed ouk?
errar ouk

Figura 16: Funcion Dequeue Element en LabVIEW
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e Transpose 2D Array: transpone los elementos de un array de dos dimensiones [i,j]

por uno de dos dimensiones [j,i].

2D array transposzed anay

Figura 17: Funcién Transpose 2D Array de LabVIEW

Para conseguir una visualizacion mas cémoda, se ha colocado la funcién de
LabVIEW Wait Until Next ms Multiple dentro del bucle While con el fin de controlar el
ritmo de ejecucion del mismo. [38]

Wait Until Next ms Multiple

A L

millisecond multiple

Figura 18: Bloque “Wait Until Next ms Multiple” de LabVIEW
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Anexo V - Codigos de programacion en el procesador de
Arduino

Se importan las librerias nec
mport processing.serial.x;
import cc.arduino.x;
import OoScPS.x*;

Arduino arduino;
OscPS oscPS;

float smile = 0; Epoc
int LED = 13; al que debe conectarse el led

void setup() {
println{Arduino.list()); busca Arduinos
comienza la comunicacion con el Arduin

arduino = new Arduino(this, "COMS", 57600);

establecemos el led como un pin de salida
arduino.pinMode(LED, arduino.QUTPUT);
comienza oscP5, recibe los mensajes del puerte 7400 (este valor
se debe comprobar ya que puede cambiar)
oscP5 = new OscPS(this. 7400):
aqui se reenvia s mensajes de 0OSC
que Tienen como EXP/SMILE to getSmile
el cual actualiza on el val del mensaje de 0SC «*
oscP5.plug(this, LE");
}
soid draw() {
[* Si el valor que recibe de smile(sonrisa) es jgual a 1, valor maximo, el
led debera encenderse. En caso contrario este permanecera apagado
if (smile == 1) {
arduino.digitalWrite(LED, arduino.HIGH);
} else {
arduino.digitalWrite(LED, arduino.LOW);
}
}
esta funcion actualiza Smile con el valor del mensaje 0SC
de /EXP/SMILE, establecido en el setup *

/oid getSmile (float theValue) {
smile = theValue;
println("0SC message received; new smile value: "+smile);

}
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Caso2
/ Trabajo Fin de Grado

Jordan Ortega y Alejandro Pacheco

Caso 2: Meditacidn

importT processing.serial.*;
import cc.arduino.x*x;

import oscPS.x*;

Arduino arduino;

OscP5 oscP5;

public float med = 0;

Ahora declaramos para cada pin un led
int ROJO = 13;
int NARANJA = 12;
int AMARILLO = 11;
int VERDE = 10;
int AZUL = 9;
int VIOLETA = 8;

void setup() {
println{Arduino.list());

arduino = new Arduino(this, "COMS5", S57600);:
arduino.pinMode(R0OJ0O, arduino.QUTPUT);
arduino.pinMode (NARANJA, arduino.OUTPUT);
arduino.pinMode (AMARILLO, arduino.CQUTPUT);
arduino.pinMode(VERDE, arduino.QOUTPUT):
arduino.pinMode(AZUL, arduino.QUTPUT);
arduino.pinMode(VIOLETA, arduino.OUTPUT)};

oscP5 = new OscPS(this, 7400);

oscP5.plug(cthis, "updateMed"," /AFF/Meditation");

void draw() {

if(med>= 0.15) {

arduino.digitalWrite(VIOLETA, arduino.HIGH);
}
if({med>=0.36){

arduino.digitalwWrite(AZUL, arduino.HIGH);

}
i f(med>=0.41){

arduino.digitalwrite(VERDE, arduino.HIGH);
}

if(med>=0.47){

arduino.digitalwrite(AMARILLO, arduino.HIGH);
}
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if{med>=0.55){

arduino.digitalWrite(NARANJIA, arduino.HIGH);
}

if{med>=0.66){

arduino.digitalWrite(R0J0, arduino.HIGH);

[

lse {

arduino.digitalWrite(VIOLETA, arduino.LOW);
arduino.digitalWrite(AZUL, arduino.LOW);
arduino.digitalWrite(VERDE, arduino.LOW);
arduino.digitalWrite(AMARILLO, arduino.LOW);
arduino.digitalWrite(NARANJA, arduino.LOW);
arduino.digitalWrite(R0JO, arduino.LOW);

1
}
public void updateMed (float theValue) {

med = theValue;

println("0SC message received; new med value: "+med);

}

m
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Anexo VI - Calibracidén electréonica

En este caso se ha pretendido realizar una calibracion electronica del dispositivo
EMOTIV EPOC en el Servicio de Electronica de la Universidad de La Laguna, de manera
que mediante una serie de sefiales generadas por un calibrador, éstas puedan ser utilizadas
para estudiar algunas de las caracteristicas electronicas del equipo, como puede ser su ancho
de banda o las amplitudes méaximas de la sefial de entrada permitidas para la correcta

adquisicion de las mismas segun la conductancia.

Debido a las caracteristicas electronicas del dispositivo, ha sido necesario elaborar
una sonda especial para la comunicacion entre éste y el generador de sefiales, ya que el
dispositivo utiliza un registro unipolar. Esto implica que cada electrodo se encuentra
referenciado frente a dos masas conectadas eléctricamente entre si, como se indica en el

esquema representativo de la siguiente figura.

i

il

Figura 1: Registro unipolar EEG del EMOTIV EPOC (Elaboracién propia)
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Para generar las sefiales simuladas se ha utilizado un calibrador electronico Fluke,
modelo 5500A, capaz de cubrir un espectro de carga de trabajo de calibracion eléctrica de

baja frecuencia.

Una vez realizada la conexion entre los equipos, se han determinado en primer lugar
los valores de tension de entrada maximos que pueden ser correctamente captados por el
equipo de electroencefalografia. Usando el Control Panel del software que trae consigo el
dispositivo EPOC puede apreciarse el estado de la conectividad entre los electrodos y la
sefial simulada, que se considerara excelente cuando se aprecien los electrodos con una sefial
luminosa en el propio software de color verde. Debe tenerse en cuenta que el EPOC todavia
trabajard correctamente aun cuando algunos sensores se muestren de color amarillo o
naranja. Asimismo, la comunicacién se considera pobre cuando se muestren de color rojo, y

nula cuando se muestren de color negro.

Sabiendo esto, se ha escogido una sefial sinusoidal de entrada con valores iniciales
de tension de 1 mV de pico y con 1 Hz de frecuencia, aplicada sobre el electrodo O1 como

ejemplo. Con estos valores la comunicacion se muestra excelente.

Contact Quality m

120

404 ‘ ‘

Amplitude (uY)

104 - \

0

20

Figura 2: Estado de la conectividad excelente. Figura 3: Sefial de entrada mostrada en el
Electrodo de color verde. Testbench.
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No obstante, como se explicard mas adelante, la sefial de entrada real no tendra estos
valores exactos debido a diversas perturbaciones causadas por el ruido eléctrico que produce

la propia sonda y demas aparatos y elementos electronicos cercanos al sistema de medida.

A medida que se varia la tension de entrada aumentando el valor de la misma
producida por el calibrador, puede observarse como decae la calidad en adquisicion de la
sefial seguin se acerca a los valores de saturacion. De esta manera, se han estimado los valores
de tension que corresponden a cada estado de la calidad de conexion entre la sefial de entrada

y los electrodos del aparato.

La tabla 1 muestra la relacion entre la calidad de conexion y los valores de tension de la

sefal de entrada.

Amplitud de la sefial de Calidad de la conexion Color del electrodo en
entrada (Vin) [mV] (conductancia) el Control Panel
0<Vin<228 Excelente Verde
2.28<Vin<2.73 Regular Amarillo
2.73<Vin< 3.68 Pobre Naranja
3.68<Vin<7.61 Critica Rojo
Vin<7.61 Nula Negro

Tabla 1: Relacion amplitud-conductancia en la adquisicién de la sefial de entrada

Una vez estudiados los limites permisibles en la variacion del valor de la tension de
entrada de la sefial, se ha intentado estudiar la respuesta del sistema de medida frente a
variaciones de frecuencia con el fin de estimar el ancho de banda préctico que presentan los

amplificadores electrénicos que se encargan de la adquisicion de las sefiales EEG.

Al variar la frecuencia, el voltaje de salida cambia debido a la reactancia del
capacitor. Esto implica que la ganancia de voltaje Vsalida/Ventrada S€ €ncuentra en funcion de
la frecuencia. La tension de salida sera aquella que pueda ser mostrada en el Test Bench del

software del propio dispositivo EPOC.

La imagen que obtenida que se muestra en el Testbench ha resultado ser nefasta

debido a los excesivos niveles de ruido que presenta la sefial. Esto se debe a la dificultad que
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supone representar sefiales de tan baja amplitud y frecuencia, altamente vulnerables a sufrir
interferencias causadas por los diversos equipos y componentes electronicos que se

encuentren proximos al entorno de trabajo.

Estos factores dificultan las labores de medida haciendo que resulten imposibles, ya
que se produciran un error excesivo. A continuacion, se muestran en la tabla 2 las medidas
tomadas, en la que constatan dicho error de forma evidente., ya que para los valores de

frecuencia estudiados, la ganancia en tension del aparato deberia ser lo méas préximo posible

a la unidad.
) Bandas o
Ventrada ) Frecuencia : )
Vsalida [mV] Ganancia [dB] potenciales
[mV] [Hz] :
correspondientes
1 1,12 1 1,008
1 1,44 1,5 3,149
DELTA
1 1,54 2 3,750
1 1,66 4 4,402
1 1,75 6 4,861 THETA
1 1,78 8 5,008
1 1,78 10 5,008
ALPHA
1 1,63 15 4,244
1 1,23 20 1,798
1 1,22 25 1,727 BETA
1 1,21 30 1,656

Tabla 2: Medidas de la ganancia de amplificacion del dispositivo

Para que la medida sea correcta, el valor de la ganancia en decibelios debe
encontrarse lo méas proximo posible a la unidad, quedando reflejado que esto no se cumple
en nuestro sistema de medida. Estos datos se comprueban en las graficas obtenidas en el

Testbench para cada valor de frecuencia.
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Montaje y resultados de la calibracion electronica del dispositivo
EMOTIV EPOC

La sonda elaborada para la medida se trata de un cable de entrada coaxial que ira
conectada al generador de sefiales con tres terminales de salida, que se conectaran a los
electrodos del dispositivo de manera que conste de una salida positiva y dos referencias de

masa. La conexion entre los terminales de salida de la sonda con los electrodos del

\

dispositivo EMOTIV se ha realizado de como se muestra en la imagen.

Figura 4: Sonda elaborada para la calibracion electronica

Tras establecer la conexidn entre los electrodos y los terminales de salida de la sonda,
deben colocarse correctamente en el dispositivo, de modo que las salidas de masa queden
conectadas a los electrodos de referencia correspondientes y la salida positiva se conecte al

electrodo cuya sefial se desee visualizar.

Figura 5: Dispositivo Emotiv EPOC preparado para la conexion con el calibrador
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Con el fin de evitar el posible movimiento causado sobre el dispositivo y fijarlo en
una posicion estable durante la medida, se ha decidido colocarlo sobre una cabeza de

maniqui.

r

(
<

Figura 6: Soporte del dispositivo EPOC en una cabeza de maniqui.

Para generar las sefiales simuladas se ha utilizado un calibrador electronico Fluke,
modelo 5500A, capaz de cubrir un espectro de carga de trabajo de calibracion eléctrica de
baja frecuencia. Permite generar sefiales sinusoidales de corriente alterna en un rango de
tensiones de entre 1 mV y 1020 V, y de frecuencias entre 0,01 Hz y 2 MHz. Asimismo,
debera conectarse la entrada coaxial de la sonda descrita anteriormente con la salida del

calibrador, como se muestra en la figura 6.
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Figura 1: Calibrador FLUKE 5500A

Al variar la frecuencia, el voltaje de salida cambia debido a la reactancia del
capacitor. Esto implica que la ganancia de voltaje Vin/Vout S€ encuentra en funcion de la
frecuencia. La tension de salida sera estudiada utilizando el Testbench del propio software
del dispositivo EPOC.

Como se explica en el Capitulo 111 de la presente Memoria, la sefial se ve perturbada
debido a ruidos de origen diverso. A continuacion, se muestran los resultados de las medidas

tomadas para cada valor de frecuencia.

Para que la medida sea correcta, el valor de la ganancia en decibelios debe
encontrarse lo mas préximo posible a la unidad. Se comprueba que debido a las
perturbaciones sobre la sefial de entrada, la sefial de salida mostrada varia considerablemente

ante pequefias modificaciones de frecuencia.
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Figura 2: Sefial de salida de 1 Hz
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Figura 3: Sefial de salida de 1,5 Hz
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Figura 4: Sefal de salida de 2 Hz
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Figura 5: Sefial de salida de 4 Hz
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Figura 6: Sefal de salida de 6 Hz
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Figura 7: Sefial de salida de 8 Hz
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Figura 8: Sefial de salida de 10 Hz
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Figura 9: Sefial de salida de 15 Hz
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Figura 11: Sefial de salida de 25 Hz
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Figura 12: Sefial de salida de 30 Hz

Como queda demostrado, la calibracidn electrénica no se ha conseguido con éxito

debido a la limitacion del material y los equipos que se han utilizado para ello. Es por este

motivo que este apartado puede quedar pendiente para futuros trabajos en los que se cuente

con un material mas apropiado para llevarlo a cabo correctamente.
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Anexo VII - Iméagenes Calibracién Biologica

V| f’ \J‘(\\ 131 \“ i ) 1%

me VT AL S e

?‘J Vf.rrr'(bw A :‘ | f'""**'l'l‘n\?h‘M},l\\“*l“»’ﬂ"(‘"““\V“-“"”“""“‘"‘*\\"‘“"' (g onfi bt

—

\/MWMA

; ’( 'WA.WMWNMM\[-M&WW"‘ |
1

il f M“\L )%/%“ ] “A"\WWM"!‘MJ:WN;\W J‘ R S
I o (K T FAl [ i

|
5
i

A i 4 i
e “«-m,\«mﬂ\w Wi i 'w\vw,,"“v\\.w,:u-w,‘-—*.WM st P
_t et """"*"‘W""/'\W'W { W T

?
|
?
i
igf

£ |3

s S L P g o SN ‘/A—”“’\r"‘\w‘..&w’ylm~ e “"V‘M RSN it PN L

i it N\‘»\/"‘/w\ AA/ﬂJ\j\_J\;\]\\JN“\, SSIANANN K,\V_;w\«/\\/«m AN SAAA

i

S

Figura 1c: Parpadeo del sujeto 3
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Figura 3a: Movimiento ocular del sujeto 1
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Figura 4c: Movimiento muscular del sujeto 3
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Figura 6d: Reposo del sujeto 4
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Figura 7c: Sujeto 3 escuchando musica
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Figura 8b: Pensamiento del sujeto 2
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Figura 8c: Pensamiento del sujeto 3
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Figura 9a: Sujeto 1 hablando y pensando
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Figura 9d: Sujeto 4 hablando y pensando
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Anexo VIII- Diagrama de bloques para la adquisicion de sefiales y potenciales EEG en OpenVIBE
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